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Chapter 1. Introducing Acronis®
Recovery™ for Microsoft Exchange

This chapter provides general information about a new Acronis product - Acronis®
Recovery™ for Microsoft Exchange– its features and advantages. You will learn about
supported databases, operating systems and platforms.

1.1 What is Acronis® Recovery™ for Microsoft Exchange?
Acronis® Recovery™ for Microsoft Exchange offers a fast and reliable disaster recovery
solution to protect your Microsoft Exchange data. It features a proven database backup
technology that will drastically reduce disaster recovery time: you can be up and
running again in minutes instead of hours. It also provides document level backup,
providing incredible flexibility that allows backing up of only individual mailboxes/public
folders and uses message filters to reduce both an archive size and duration of a
backup process.
Acronis Recovery for MS Exchange is available in two versions – original Acronis
Recovery for MS Exchange for larger organizations and Acronis Recovery for MS
Exchange Small Business version (Acronis Recovery for MS Exchange SBS) for small
and/or start-up businesses. See 1.3 “Acronis Recovery for MS Exchange or Acronis
Recovery for MS Exchange SBS?” for more information.

One-step Recovery and Automated Recovery to a Point-of-Failure reduce downtime
and helps improve your organization’s Recovery Time Objective (RTO).

Acronis Recovery for MS Exchange is an excellent complement to the award-winning
Acronis True Image suite of disaster recovery and system migration products that use
patented disk-imaging technology. Together they deliver comprehensive server system
backup and restore and also full Microsoft Exchange database protection — a winning
disaster recovery plan combination.
•

Ultimate Granularity
Acronis Recovery for MS Exchange provides the ultimate in granularity for
backup and restore. Backup and restore operation can be applied to a
whole information store, individual storage groups, mailboxes/public
folders or even single emails.
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With Acronis Recovery for MS Exchange you can restore your crucial
mailboxes or single emails from different kinds of backup – not only from
brick-level backups, but from a whole-database backup archive as well.
•

Smaller, more manageable archives
Award-winning Acronis technology provides superior image file optimization.
Customizable compression rates reduce the amount of data to store and
transfer, leading to direct cost savings in storage and labor.

•

High Speed
Acronis Recovery for MS Exchange provides proven database backup
technology that maximizes backup speed.
With its ability to restore any data (mailboxes, public folders or individual
emails) from a database level backup, Acronis eliminates the need for timeconsuming brick-level backups.

•

Active Restore™
Active Restore™ mode provides full Microsoft Exchange Server functionality
for users in minutes, while the system is still being restored. Using Active
Restore™, combined with automated Dial-tone restore mode, you can limit
downtime of your Microsoft Exchange 2007 Server to only seconds.

•

Continuous Data Protection
Continuously back up transactions to enable the complete restoration of
Microsoft Exchange Server databases with minimum data loss.

•

Faster Disaster Recovery
One-step Recovery and Automated Recovery to the point-of-failure help
organizations meet aggressive Recovery Time Objectives (RTO).

•

Encryption for Security
Protect companies' most valuable data with industry-standard encryption.

•

Centralized Management
The Acronis® Recovery™ for Microsoft Exchange Management Console
automatically detects all database servers on the network. The servers are
displayed clearly with status information, making it easy to manage
enterprise-wide installations.

•

Resource Management
CPU and bandwidth throttling let you allocate resources during the backup
process to ensure users remain productive.

•

Guided Disaster Recovery
Acronis database backup also provides you with a Disaster Recovery Plan,
detailing step-by-step instructions to guide you or your team through a fast
and complete recovery. Even non-technical staff members can follow these
simple instructions to restore even the most sophisticated Microsoft
Exchange server.

•

Integration with Acronis True Image Echo
Installed on the same computer, Acronis True Image Echo Update (build
8115 or later) and Acronis Recovery for MS Exchange can restore a whole
8

production server (operating system and whole information store) on bare
metal from bootable CD or from a PXE.
•

Easy Administration
Intuitive wizard-driven GUI allows even non-DBAs to confidently configure
and implement professional backup strategies.

1.2 Why Acronis Recovery for MS Exchange?
Comprehensive recovery requires more than just a backup of information stores. Your
Microsoft Exchange mailbox server contains storage groups, logs, mailboxes, public
folders, mails, and other components that structure the data. Using Acronis Recovery
for MS Exchange, a cohesive and intuitive backup solution, is the critical step you can
take to ensure a secure live Microsoft Exchange mailbox server backup that can be
quickly recovered.
With Acronis Recovery for MS Exchange restoring individual emails became easier –
you can do it from any kind of backup (both database and brick-level).
Recovery is now made easy with automated system restore to a point-of-failure. There
is no need to walk through menus to get your system back online. This one-step
process will return your database to the last known good state just before failure.
Erroneous transactions will no longer cost you minutes or hours in recovery.
This powerful product includes an intuitive wizard-driven GUI that guides you through
the scheduling process and reduces the possibility of errors. The Backup Strategy
Assistant creates a Disaster Recovery Plan for your environment, delivering step-bystep instructions for recovery. Anyone, whether an experienced DBA or not, can
schedule backup jobs and handle system restores rapidly. Acronis even provides FTP
capability for storing your backup on any FTP server, worldwide.

1.3

Acronis Recovery for MS Exchange or Acronis
Recovery for MS Exchange SBS?

You can choose the appropriate license for Acronis Recovery for MS Exchange. Your
choice is based on the size environment it will be installed in:
•

Acronis Recovery for MS Exchange, appropriate for larger businesses

•

Acronis Recovery for MS Exchange Small Business Version (Acronis
Recovery for MS Exchange SBS). This less expensive alternative is tailored
for small and/or start-up businesses. The agent can only be installed on
Windows SBS 2003 and Windows SBS 2008 operating systems. Acronis
Recovery for MS Exchange SBS can be upgraded to Acronis Recovery for
MS Exchange through using the full version serial number while installing
the product. See 1.10 for details.
Please note, Acronis Recovery for MS Exchange Agent cannot be installed on
the SBS server remotely with SBS license. For remote installation use the
enterprise serial number, or install it locally.

1.4 Advantages
With Acronis Recovery for MS Exchange you get the following advantages:
•

Hot Backup
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Backup can be performed while the Microsoft Exchange service is online
and serving clients allowing 24/7 availability
•

Restore Emails from Database Level Backup
Acronis Recovery for MS Exchange provides the ability to restore specific
emails from database level backup

•

Tuning a Backup Strategy with Acronis® Recovery™ for Microsoft
Exchange Assistant
Acronis Recovery for MS Exchange Assistant provides an intuitive GUI for
easy creation and implementation of a backup strategy, even without DBA
experience

•

Disaster Recovery Plan
Automatically creates and e-mails Disaster Recovery Plans with step-by-step
instructions on recovering databases. The guided process makes it possible
for staff to restore databases quickly, even without DBA skills

•

Recovery to a Selected Point-in-Time
With transaction log backed up, Acronis Recovery for MS Exchange allows
you to specify a date and time to restore your data from

1.5 Key Features
•

Database Backup (Fastest Method)
Acronis Recovery for MS Exchange provides the ability to backup all data at
a database level. This is the fastest, but the least flexible backup method

•

Brick-Level Backup
Acronis Recovery for MS Exchange provides the ability to backup all data at
a documents level (brick-level). This is not the fastest, but the most flexible
backup method

•

Bare Metal Restore
The bare metal restore feature restores a whole production server
(operating system and all databases) on bare metal from a bootable CD or
from a PXE. This feature is available only if Acronis True Image Echo
Update (build 8115 or later) and Acronis Recovery for MS Exchange are
installed on the server

•

Automated recovery to point-of-failure
Automated recovery to point-of-failure allows easy one-step recovery to a
point just before failure or disaster with no loss of data

•

Encryption
Protect backups with industry strength-standard encryption technology. AES
(Advanced Encryption Standard) is available with three key lengths – 128,
192 and 256 bits to balance performance and protection as desired

•

Compression
Create backups up to 10 times smaller than the original uncompressed
format. Three compression levels let you optimize for faster performance,
smaller size, or a balance of both
10

•

Dial Tone Recovery
Acronis Recovery for MS Exchange can restore e-mail service more quickly
to users (providing them with a basic "dial tone") and then restore users'
previous data as it becomes available

•

Bandwidth Throttling
Control bandwidth usage to keep the backup process transparent to
network users

•

Notifications
Configure notification via e-mail and SNMP

•

Automated recovery staging
Every restore scenario can be executed in one step. There is no need to
manually restore from different archives keeping in mind the database state

•

Scheduling complete backup strategy
Schedule the complete backup strategy, including Full and Incremental
backup in one action

•

Restore Mailboxes from Brick-Level Backup
The system provides the ability to restore mailboxes from brick-level backup

•

Restore Mailboxes from Database-Level Backup
The system provides the ability to restore mailboxes from database level
backup

•

Restore Emails from Brick-Level Backup
Acronis Recovery for MS Exchange provides the ability to restore specific
mails from brick-level backup

•

Command-Line Mode
The system provides command-line user interface

1.6 Supported Microsoft Exchange versions
•

Microsoft Exchange Server 2007 (Standard/Enterprise Editions)

•

Microsoft Exchange Server 2003 (Standard/Enterprise Editions)

•

Microsoft Exchange Server 2000 Server with post-Service Pack 3 rollup
(Standard/Enterprise Editions)
Important! Acronis Recovery for MS Exchange Agent is only guaranteed
to work with Microsoft Exchange Server 2003 service packs installed. Note, to
handle MAPI interfaces correctly, Service Pack 2 and hotfix kb908072 must be
installed (see Microsoft website for details).

Please note, Acronis Recovery for MS Exchange is not a cluster-aware product.

1.7 Supported Platforms
•

x86 (for Microsoft Exchange Server 2000/2003)
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•

x86-64

1.8 Supported Operating Systems for Acronis Recovery
for MS Exchange Agent
For Acronis Recovery for MS Exchange:
•

Windows 2000 (SP4 Rollup 1)

•

Windows Server 2003 (both 32-bit and 64-bit versions)

•

Windows 2008 Server

For Acronis Recovery for MS Exchange Small Business Edition:
•

Windows SBS 2003

•

Windows SBS 2008

1.9 Supported Operating Systems for Acronis Recovery
for MS Exchange Management Console
•

Windows XP (SP 2)

•

Windows Vista

•

Windows 2000 (SP4 Rollup 1)

•

Windows 2003

•

Windows 2008

1.10 License Policy
Acronis Recovery for MS Exchange licensing is based on the number of servers on
which Acronis® Recovery™ for Microsoft Exchange Agent is to be installed. You will
need a unique serial number to install every single Acronis Recovery for MS Exchange
Agent.
Acronis Recovery for MS Exchange is provided with the following types of licenses:
Permanent (Enterprise or SBS) – allows you to use the fully functional product
without any time limitations (permanent serial number is required)
Trial - allows you to use the fully functional product for 30 days (trial serial number is
required)

Obtaining Permanent Serial Numbers
Obtaining a permanent serial number depends on the way you purchase Acronis
Recovery for MS Exchange:
•

you will find it in the CD box if you buy the licensed Acronis Recovery for
MS Exchange CD

•

you can receive it by e-mail after registering on the Acronis web site in case
you download the product (also during installation of the product)
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Trial Serial Numbers
Acronis allows you to have a trial serial number to be able to use Acronis Recovery for
MS Exchange for 30 days without buying the product. You may obtain the trial serial
number in one of the following ways:
• in the CD box, distributed during promotion events
• after downloading the product from the web site
• after registering in installation wizard (the serial number will be sent by email)
• contacting Acronis sales representatives. Visit
http://www.acronis.com/enterprise/products/ARExchange/gettrial/
You have to sign in (or register) to obtain a trial serial number.
If you downloaded a trial version of Acronis Recovery for MS Exchange from our web
site and want to buy a permanent license to continue using the product, please contact
our sales representatives. In this case you will not have to download the product
again, but only enter a registered serial number during the installation.
Note, the Management Console should be connected to Acronis Recovery for
MS Exchange, otherwise the Registration menu item will not be presented in
the Help menu.
The number of Acronis Recovery for MS Exchange Management Console installations is
not limited.

1.11 Technical Support
As part of a purchased annual Support charge you are entitled to Technical Support as
follows: to the extent that electronic services are available, you may electronically
access at no additional charge, Support services for the Software, which Acronis shall
endeavor to make available twenty four (24) hours a day, seven (7) days per week.
Such electronic services may include, but are not limited to: user forums; softwarespecific information; hints and tips; bug fix retrieval via the internet; software
maintenance and demonstration code retrieval via a WAN-accessible FTP server; and
access to a problem resolution database via Acronis customer support system.
Support shall consist of supplying telephone or other electronic support to you in order
to help you locate and, on its own, correct problems with the Software and supplying
patches, updates and other changes that Acronis, at its sole discretion, makes or adds
to the Software and which Acronis makes generally available, without additional
charge, to other licensees of the Software that are enrolled in Support. Upon mutual
agreement by both parties, Acronis shall: (i) supply code corrections to you to correct
Software malfunctions in order to bring such Software into substantial conformity with
the published operating specifications for the most current version of the Software
unless your unauthorized modifications prohibit or hamper such corrections or cause
the malfunction; or (ii) supply code corrections to correct insubstantial problems at the
next general release of the Software.
More information about contacting Acronis Technical Support is available at the
following link: http://www.acronis.com/support/
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Chapter 2. Understanding Acronis
Recovery for MS Exchange

This chapter provides common information about working with Acronis Recovery for
MS Exchange.

2.1 Components
Acronis Recovery for MS Exchange includes the following components:
•

Management Tools including
Management Console

Acronis

•

Acronis Recovery for MS Exchange Agent

Recovery

for

MS

Exchange

2.1.1
Acronis Recovery for MS Exchange Management
Console
Acronis Recovery for MS Exchange Management Console is a tool for managing data
backup/restore on the local network from a single location. Using it, you can install
agents remotely, schedule tasks, recover data remotely, and set backup/restore
options on remote Exchange servers.

2.1.2

Acronis Recovery for MS Exchange Agent

The Acronis Recovery for MS Exchange Agent is installed on the computers on which
you want to backup/restore a Microsoft Exchange database.

2.2 Components Integration
Acronis Recovery for MS Exchange Management Console is installed on the computer
from which you plan to manage operation processes on remote database servers.
After issuing a backup or restore command from the Management Console, Acronis
Recovery for MS Exchange sends a request to the Acronis Recovery for MS Exchange
Agent to retrieve the required storage group or mailbox from Microsoft Exchange and
sends it to Acronis Recovery for MS Exchange, which backs up the selected data.
Below are diagrams describing interaction between Management Console and Agent.
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Integration between Acronis Recovery for MS Exchange and Acronis Recovery for MS
Exchange Agents

2.3 Integration with Acronis True Image Echo Enterprise
Server
Acronis Recovery products are integrated with Acronis True Image Echo Enterprise
Server Update (build 8115 or later) that provides the ability to automatically execute
preconfigured restore tasks in case of disaster.
There are three points of integration:
•

Ability to start Acronis Recovery for MS Exchange tasks from the Acronis True
Image Echo Enterprise Server management console

•

Bare metal restore

•

Microsoft Exchange Server files exclusion while creating backup tasks with
Acronis True Image Echo Enterprise Server

2.3.1 Starting Tasks from the Acronis True Image Echo
Enterprise Server Management Console
Integration allows accessing main Acronis Recovery for MS Exchange functions
(wizards and tools) from the Acronis True Image Echo Enterprise Server management
console in case if both consoles are installed on the same computer. The Acronis
Recovery for MS Exchange Agent must be installed on the remote computer.
Clicking the corresponding button, user will launch the desired Acronis Recovery for MS
Exchange wizard or tool directly. This functionality will be disabled if any of Acronis
Recovery for MS Exchange Agent or Management Console is not installed.

2.3.2 Bare Metal Restore
Acronis Recovery for MS Exchange provides the ability to restore a whole production
server on bare metal from a bootable CD or from the PXE. This functionality is provided
by Acronis True Image Echo Enterprise Server.
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Configuring Bare Metal Restore
To restore all necessary information stores on bare metal or to create a bootable
media, you need a previously created archive with required information stores backed
up.
After creating an archive, do the following:
1. Launch a Restore wizard to schedule a restore task and choose a Bare Metal
Restore option in the first step.
2. Specify a task execution account.
3. Choose an archive and point in time (point of failure), select the necessary storage
groups and set additional parameters (such as a password) for each archive.
4. Backup a partition with Acronis Recovery for MS Exchange installed using Acronis
True Image Echo Enterprise Server (see Acronis True Image Echo Enterprise Server
User’s Guide for detailed information).

Restoring a Server from a Bootable Media
After hardware failure it is necessary to restore the whole system, including the
operating system and databases, located on different hard drives. To restore partitions
and storage groups/databases (to the last possible state), do the following:
1. Start the computer from a bootable media, previously created using Acronis True
Image Echo Enterprise Server.
2. Execute an Echo bare metal restore (see Acronis True Image Echo Enterprise Server
User’s Guide for detailed information).
In case a company stores databases on external SAN/NAS, and an administrator only
needs to restore an operating system, the following actions should be performed: start
the computer from a bootable media, previously created using Acronis True Image
Echo Enterprise Server, and then execute an Echo bare metal restore (see Acronis True
Image Echo Enterprise Server User’s Guide for detailed information).
If databases are stored on SAN/NAS, while preparing for restoring, do not configure
bare metal restore tasks, as described in section “Configuring Bare Metal Restore”.

Starting a Bare Metal Restore Task
In case of hardware failure you have to restore the lost partition using the Acronis True
Image Echo Enterprise Server, and then start the Acronis Recovery for MS Exchange
bare metal restore task. To start this task automatically, you need to select the Run
Acronis Recovery for MS Exchange Bare Metal Restore after data recovery
option in the final step of the Acronis True Image Echo Enterprise Server Restore
Data wizard.

2.3.3 Files Exclusion
Integration allows users to exclude Microsoft Exchange Server files while backing up a
partition with Acronis True Image Echo Enterprise Server.
To exclude Microsoft Exchange Server files (*.edb, *.stm, *.log, *.pat), in Acronis True
Image Echo Enterprise Server Create Backup wizard at Source Files Exclusion step
select the Exclude all MS Exchange databases files option.
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Chapter 3. Installation of Acronis
Recovery for MS Exchange

From this chapter you will learn how to install Acronis Recovery for MS Exchange
components both locally and remotely.

3.1 Minimum System Requirements
Acronis Recovery for MS Exchange requires the following hardware:
•

Pentium processor or higher

•

1024 MB RAM

•

Mouse (required)

3.2 Security Policy
3.2.1 Credentials
Acronis Recovery for MS Exchange obtains access to networked computers using
Administrator credentials. For detailed information on how to configure required
credentials, see section 4.1.

3.2.2 Firewall Settings
Acronis Recovery for MS Exchange uses the following ports for remote operation:
•

server (Acronis Recovery for MS Exchange Agents) UDP port: 9876

•

server (Acronis Recovery for MS Exchange Agents) TCP port: 9876, if busy
choose a port at random

•

client (Acronis Recovery for MS Exchange)
choose a port at random

UDP port: 9877, if busy

You might have to set the appropriate firewall access options. Options for the Windows
Firewall, included in Windows XP Service Pack 2, Windows 2003 Server and later
Windows versions, are set automatically during installation of Acronis Recovery for MS
Exchange components. If necessary, add Acronis Recovery for MS Exchange to the
firewall exceptions list before installing the management console on Windows 2008 and
other Microsoft operating systems.
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However, make sure that the option File and Printer Sharing in the Control panel
-> Windows Firewall -> Exceptions is enabled on the remote computer, before
the remote operation starts.

3.3 General Rules of Installation
Acronis Recovery for MS Exchange components and their features can be installed in
multiple configurations, in terms of distributing the components and features among
the networked computers.

3.3.1
Installing
Components

Acronis Recovery for MS Exchange

There are two ways to install Acronis Recovery for MS Exchange components – local
and remote.
To install Acronis Recovery for MS Exchange Management Console and Acronis
Recovery for MS Exchange Agent locally:
•

run the Acronis Recovery for MS Exchange setup file

•

in the Install Menu, select the program to install: Acronis Recovery for MS
Exchange Management Tools or Acronis Recovery for MS Exchange Agent

•

follow the install wizard instructions on the screen

It is recommended that you install Acronis Recovery for MS Exchange Management
Console first. This will allow you to install Acronis Recovery for MS Exchange Agent
remotely from the Management Console to any networked computer (for information
about the remote installation see 3.3.2 “Installing Acronis Recovery for MS Exchange
Agent remotely”).
It is strongly recommended to manually stop CDP process before starting the
installation of the product to be able to update all required components.
Otherwise you may need to reboot the server after installation completion.
In addition, Acronis Recovery for MS Exchange supports the Microsoft Installer utility
(msiexec.exe) and its commands, so that you can install Acronis Recovery for MS
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Exchange components from a command line. MSI installation command and options
are listed in Appendix B.

3.3.2

Installing Acronis Recovery for MS Exchange Agent
Remotely

To install Acronis Recovery for MS Exchange Agent remotely on a database server, you
first need Acronis Recovery for MS Exchange Management Console installed on the
local computer. The remote system must meet the requirements described in 3.1
“Minimum System Requirements”.
Before remotely installing Acronis Recovery for MS Exchange Agent on
Windows 2008 Server, open port 25001 for TCP protocols for an inbound
connection.
While installing Acronis Recovery for MS Exchange Agent, a new registry key is
generated. If you previously had Acronis Recovery for MS Exchange Agent installed or
you had reinstalled the operation system on the current computer, you will need to
clear the key registry cache on the computer, where Acronis Recovery for MS
Exchange Management Console is installed, for correct product functioning.
Run Acronis Recovery for MS Exchange and click Install Acronis Recovery for MS
Exchange Agent in the Pick a Tool pane.
1. Specify the location of installation files of the Acronis Component you want to
install.
•

Select from the registered components (by default)

•

Search removable media for the required installation files

•

Search for the installer in the specified location (you will have to specify the
location by clicking Browse…)

Click Next to continue.
2. Select the program you want to install on the remote computer from the list
(Acronis Recovery for MS Exchange Agent) and click Next.
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3. Enter a serial number for the selected product. For information about obtaining
a serial number, see section 1.10 “License Policy”. The Next button will not be
active until you enter a serial number.

4. Select the computer in the Computer field: enter a computer name manually
or click Browse… and select the required computer from the tree. Enter the
Domain name, a User name and password into the corresponding fields to
access the selected computer. By selecting the Save password check-box you
can save the password for future connections.
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5. The summary page displays all operations, which will be performed. Click
Proceed to install Acronis Recovery for MS Exchange Agent on the remote
computer.

By connecting to a remote computer with Acronis Recovery for MS Exchange Agent
installed, you can set up backup and recovery tasks, and browse logs.

3.3.3

Extracting Acronis
Components

Recovery

for

MS

Exchange

To install Acronis Recovery for MS Exchange from the command line, you need to
extract the .msi file prior to starting the installation process. Here are the steps for
extracting the file:
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•

run the Acronis Recovery for MS Exchange setup file;

•

in the Install Menu, right-click on the component name and select Extract;

•

select a location for the setup file and click Save.

3.3.4 Removing Acronis
Components

Recovery

for

MS

Exchange

You can remove any Acronis Recovery for MS Exchange component separately by
selecting Control panel -> Add or Remove Programs -> <component name> > Remove.
Component names are: Acronis Recovery for MS Exchange and Acronis Recovery for
MS Exchange Agent.
Follow instructions on the screen. You may need to reboot your computer to complete
the uninstallation.
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Chapter 4. Getting started with
Acronis Recovery for MS Exchange

This chapter will help you to start working with Acronis Recovery for MS Exchange, and
will guide you through connecting to a remote server, and remote installation of
Acronis Recovery for MS Exchange Agent.

4.1 Running Acronis Recovery
Management Console

for

MS

Exchange

To run Acronis Recovery for MS Exchange Management Console, select Start ->
Programs -> Acronis Recovery for MS Exchange Management Console ->
Acronis Recovery for MS Exchange Management Console.
Important! Before starting managing the servers’ list (discovering, adding or
deleting servers), modifying the storage groups list for the Disaster Recovery
Plan (see Chapter 6), or changing default options (while creating backup or
restore tasks), make sure the required users have read/write permissions for
the following files, located in Documents and Settings\All Users\Application
Data\Acronis: DatabaseServersExtensions\serverslist.dat for Acronis Recovery
for MS Exchange Management Console, DisasterRecoveryPlans\dbaselist.dat
and RecoveryMSExchangeAgent\settings.cfg for Acronis Recovery for MS
Exchange Agent.
Note, in case Acronis Recovery for MS Exchange Agent is installed on
Microsoft Windows 2000 with Microsoft Exchange 2000 or 2003,
BackupUser/BackupGroup (a user or a group of users, who will start and
manage tasks) must be a member of Domain Admins group. If the Agent is
installed on Microsoft Windows Server 2003 or 2008 with Microsoft Exchange
2007 installed, the user must be a member of Exchange Organization
Administrators group as well. To configure these settings, go to Control Panel
 Administrative Tools. Then sequentially add the BackupUser/BackupGroup
in each of the following security policies: Domain Controller Security Settings,
Domain Security Settings and Local Security Settings (Local Policies  User

Rights Assignment  Access this computer from the network;
Adjust
memory quotas for a process; Impersonate a client after authentication; Log
on as a service). Check that the user does not have the following user rights
assignment: Deny log on as a service and Deny log on as a batch job service.
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In any case the user must have a mailbox on the Microsoft Exchange server.
Please be aware: Acronis Recovery for MS Exchange will not operate if there is no free
space on the system partition, and the software does not send notices when there is
no free space.

4.2 Acronis Recovery for MS Exchange Workspace
Acronis Recovery for MS Exchange workspace includes the Acronis Recovery for MS
Exchange Management Console window - the primary tool for managing data
backup/restore on local and remote computers where Acronis Recovery for MS
Exchange Agent is installed.
The workspace consists of the main area with operation icons, as well as the menu,
the toolbar, and the common tasks bar. On the left there is a sidebar featuring the
Computers or Help panels.
Note, that the content shown in the main window will change depending on
whether Acronis Recovery for MS Exchange Management Console is
disconnected or connected to a remote server.

4.2.1 Main Area
The main area of Acronis Recovery for MS Exchange workspace contains Task and
Tools groups.
Before you connect to an Exchange server where Acronis Recovery for MS Exchange
Agent is installed, operation icons will appear in the main program window that will
allow you to navigate and manage computers.
The Pick a Task group contains one operation:
Connect to a Remote Computer – connect to a remote server where
Acronis Recovery for MS Exchange Agent is already installed
If you select a server in the Computers pane, on which Acronis Recovery for MS
Exchange Agent is not installed, Acronis Recovery for MS Exchange workspace will
display two operation icons in the Pick a Tool group:
•
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•

Add Servers – add a Microsoft Exchange server to the group

•

Install Acronis Agents – install Acronis Agents on remote computers

As soon as you are connected to a Microsoft Exchange server where Acronis Recovery
for MS Exchange Agent is installed, your workspace will show operations you can
execute on this server, such as backup or restore, managing tasks, etc.
In this case the main area contains operation icons divided into two groups.
The Pick a Task group contains the following operations:
•

Back Up Information Store – create storage groups backup archive

•

Back Up Mailboxes – create mailboxes and public folders backup archive

•

Restore Information Store – restore storage groups from a previously
created archive

•

Restore Mailboxes – restore mailboxes and public folders from a
previously created archive

• Backup Location Clean-up - clean database backup locations
The Pick a Tool group contains the following items:
•

Restore E-mails – restore separate e-mails from a previously created
archive

•

Manage Tasks – manage tasks scheduled on a computer

•

Logs – open the Log Viewer window

•

Disaster Recovery Plan – generate step-by-step instructions on how to
restore your databases in case of any kind of failure
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4.2.2 Computers Pane
The Computers pane is located on the left side of the main program window. It
displays computers (with their Microsoft Exchange servers identified) which have been
discovered by the system or added manually.
Acronis Recovery for MS Exchange Management Console allows you to connect to a
remote computer where Acronis Recovery for MS Exchange Agent is already installed,
or to install Acronis Recovery for MS Exchange Agent remotely.
At the top of the Computers pane there is a toolbar with the following buttons:
•

Add server - opens the Add Server window, where you can specify a
server to be added to the tree

• Discover servers - automatically finds servers on the network and adds
them to the tree
• Delete server - removes the selected server from the tree

4.2.3 Program Menu
The program menu bar features the Tasks, Tools, View and Help items.
The Operations menu contains five available operations:
•

Backup Information Store - create storage groups backup archive

•

Back Up Mailboxes – create mailboxes and public folders backup archive

•

Restore Information Store - restore storage groups from a previously
created archive

•

Restore Mailboxes – restore mailboxes and public folders from a
previously created archive

•

Backup Location Clean-up - clean database backup locations

The Tools menu contains five available operations:
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•

Restore E-mails – restore separate e-mails from a previously created
archive

•

Manage Tasks – manage tasks scheduled on a computer

•

Logs – open the Log Viewer window

•

Disaster Recovery Plan – generate step-by-step instructions on how to
restore your databases in case of any kind of failure

Options – open a window for editing default backup/restore options,
setting text appearance (fonts), configuring notifications etc
The View menu contains an item for managing the appearance of the program
window:
•

•

Status Bar – enables/disables the status bar
Acronis Recovery for MS Exchange allows using shortcut keys to navigate
through the program menu. To do this, hold down <Alt> and press the access
key (the underlined letter) of the required menu item. A selected item
becomes active, and still holding down <Alt>, press the access key of the
required command from the submenu.

4.2.4 Help Menu
The Help menu is used to invoke help and obtain information about Acronis Recovery
for MS Exchange.
To view the Help panel, disable the Computers Tree option in the View menu.

4.2.5 Status Bar
At the bottom of the main window, there is a status bar divided into two parts. The left
side briefly describes the selected operation; the right side indicates operation progress
and results. If you double-click on the operation results, you will see the logs window.

4.3 Navigation
At the top on the Computers pane there are four buttons; clicking them allows you to
add new servers to the tree manually, to start the discovering process, to delete a
server from a tree if needed, or to refresh the Computers Tree.
Computers with Acronis Recovery for MS Exchange Agent already installed are marked
with a green icon.
Select the required server from the tree to perform the required operation (connecting,
installing Acronis Recovery for MS Exchange Agent remotely).
To hide the Computers pane and view Help topics, click on the Show or Hide button
from the menu.

4.4 Management
Acronis Recovery for MS Exchange Management Console allows installation of Acronis
Recovery for MS Exchange components on remote computers. To perform any of these
operations you will need administrator rights on the target machine.
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To connect to the server click Connect to a Remote Server in the Pick a Task pane
(see 4.7 “Connecting to a Remote Microsoft Exchange Server”). If Acronis Recovery for
MS Exchange Agent is not installed on a server, click Install Acronis Agents in the
Pick a Tool pane (see Chapter 3 “Installation of Acronis Recovery for MS Exchange”).
To add a new server to the tree pane, click Add Servers in the Pick a Tool pane (see
4.6 “Adding Servers”).

4.5 Discovering Servers
The purpose of discovering servers is to find servers on the network automatically and
add them to the list in the Computers pane. The first time the program is executed,
the list in the Computers pane list is empty and you will be prompted to discover
servers. In order to be able to create backup and recovery operations on servers, you
should launch the search or add servers to the list manually.
To discover servers click on the Discover Computers icon from the Computers pane
on the left. You will be asked if you want to search for database servers on the
network. Click YES to do it immediately, or NO to do it later. Discovery will update the
current status of all computers already included in the list.
If, for any reason, a server cannot be found with this tool, you can add it manually to
the tree (see 4.6 “Adding Servers”).
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4.6 Adding Servers
If you cannot locate a server with the Discover Computers tool, you can add it to the
tree manually.
You can apply any discovery operation later as required. The operation will add newly
connected servers to the list in the Computers pane. At the same time, discovery will
update the current status of all computers already included in the list.
You can start an Add Computer dialog to add servers to the tree of the Computers
pane in several ways. Here are two:
•

Click on the Add Servers icon in the main area

•

Click on the Add Servers button in the Computers pane toolbar

1. Enter the server name or IP address manually in a Server field or choose it
from the drop-down list. You can also click Browse to view all available
computers and select the one you want to add.
2. Click OK to add the server to the tree.

4.7 Connecting to a Remote Microsoft Exchange Server
In order to perform any operation on a remote Microsoft Exchange server, you must
first connect to it. Once connected, you can manage tasks: set up backup/restore
options on remote database servers and schedule backup, restore and backup location
clean-up tasks.
Before connecting to a server, make sure the user has rights to access the registry key
HKLM\Software\Acronis\Encryption\Client\RecentConnections on the computer where
the Acronis Recovery for MS Exchange Management Console is installed. Otherwise it
will be impossible to check the SSL certificate.
To establish a remote connection, select a server in the Computers pane and click
Connect to a Remote Computer in the right pane.
If you have connected to this server previously, Acronis Recovery for MS Exchange will
use credentials for accessing the computer automatically. Otherwise a dialog window
will be opened:
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•

In the Computer field, enter the name or the IP address of the computer
or select a computer from the drop-down list, by clicking the Browse...
button

•

To provide credentials for accessing the computer, click the Options>>
button

•

Specify the domain, username and password on the server you want to
connect to, in the corresponding fields

•

Select the Save Password check box if you want to save the password

•

In case the console cannot connect to a remote host, select Clear
credential cache before connect parameter and try again.

Note, that username (including the domain name) and password must be defined
explicitly while connecting to a stand-alone Microsoft Exchange Server.
Having provided all the necessary information for connection, click OK to establish
connection.
If Acronis Recovery for MS Exchange Management Console cannot connect to
the remote computer which was not rebooted after installing Acronis Recovery
for MS Exchange Agent, connection must be established with explicit
credentials.
As soon as you connect to a database server, you can manage tasks as if it is as a local
computer.

4.8 Remote Installation of Acronis Recovery for MS
Exchange Agent
The remote installation of Acronis Recovery for MS Exchange Agent is described in
detail in 3.3.2.
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Chapter 5. Creating Backup Archives

This chapter provides general information about backup types, describes how to
backup Microsoft Exchange information stores, storage groups or even
mailboxes/public folders, and which options can be set using Acronis Recovery for MS
Exchange.

5.1 General Information
Backup is crucial to maintaining a timely and consistent record of your Microsoft
Exchange servers for recovery in case of failure. Acronis Recovery for MS Exchange
offers an easy and flexible process for creation of backup archives.

5.1.1 What is a backup?
The concept of backing up data is based on copying it to a safe place to restore when
necessary. With an active database you need to backup and protect more than just
your database files and data. Databases include many components, such as transaction
logs, that must be backed up as well to make sure your data will be fully functional
after restoration.
Acronis Recovery for MS Exchange is a tool that backs up the necessary tables, data,
and user-defined objects, but it treats the database as more than just a combination of
files. When the backup procedure starts, Acronis Recovery for MS Exchange finishes all
the active transactions, makes a snapshot of the database and resumes the
transactions immediately. The database idle state is minimal and the backup will be
written to the archive location while the database is online.
Using this process to back up the database ensures that the restored copy will
be fully operational. Since the copy is made according to the snapshot, no
transactions made after the start of the process will be included into the
current backup.

5.1.2 Backup Types
Acronis Recovery for MS Exchange can create full and incremental backups for
comprehensive protection of your data from hardware failure, user errors or even
natural disaster.
A full backup contains all data at the moment of backup creation – a complete storage
group or mailbox/public folder. You can recover the entire database by restoring the
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database from a full database backup to a chosen location. Enough of the transaction
log is included in the backup to let you recover the database to the time when the
backup finished. When the database is recovered, uncommitted transactions are rolled
back. The restored database matches the state of the original database when the
backup finished, minus any uncommitted transactions.
For a small database that can be backed up quickly, it is convenient to use only full
database backups. However, as the database becomes larger, full backups take more
time to finish and require more storage space. Therefore, for a large database, you
might want to supplement full database backups with incremental backups.
A full backup can form a base for further incremental backups or can be used as a
standalone archive.
The incremental backup records all transactions and database modifications made by
each transaction since the last full or incremental backup were created. The
transaction log is a crucial component of the database and, if there is a system failure,
applying the transaction log might be required to bring your database back to a
consistent state. The transaction log file has a fixed size and an automatically
generated filename. After creating the incremental backup, transaction logs will be
truncated.
To choose the appropriate backup type (or types), you have to determine how you
need to make the data available for recovery. Your overall backup strategy defines the
type and frequency of backups as well as the type and capacity of the hardware
required for the archive location. See the next section 5.1.3 “Which Backup Strategy to
Choose?” for our recommendations.

5.1.3 Which Backup Strategy to Choose?
Follow the recommendations below to define the best backup strategy for your
organization:
•

•

•

Database activity is low to medium:
-

Full backup once a week

-

Incremental backup every 12 hours

Database size is small to medium, but activity is high:
-

Full backup every two days

-

Incremental backup every ten minutes

Database size is large and activity is high:
- Full backup once a week
- Incremental backup every ten minutes

For advice on creating the best strategy you can also rely upon Acronis Recovery for
MS Exchange Assistant while working with the Create Backup wizard. See 5.2.5 for
detailed information.
We recommend that you do not use several third-party backup tools
simultaneously since backup operations may conflict. Instead, combine
different backup types to protect your data with Acronis Recovery for MS
Exchange.
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5.1.4 Server Roles
As a messaging system that is widely used in both large organizations and small
businesses, Microsoft Exchange Server has always been scalable in both directions.
However, new demands on messaging – such as compliance, security, and disaster
recovery – have created new challenges for delivering a messaging system that works
well in small businesses and large enterprises alike.
Microsoft Exchange Server provides a complete messaging system that can run on a
single server – meaning that all Exchange services reside on one server, as with the
Microsoft Small Business Server product. However, there are significant gains in
deployment, management, and security that come from having a flexible, modular
system that can be installed across more than one machine. Customers would typically
customize their Microsoft Exchange Server 2003 installation, creating specific server
roles manually. In Microsoft Exchange Server 2007, roles are predefined and chosen
during installation. The role selected during installation ensures that only the necessary
services and components are installed.
Microsoft Exchange Server has the following server roles:
• Client Access role - similar to the front-end server in earlier versions of
Microsoft Exchange Server, this server proxies Internet client traffic to the
correct mailbox server.
• Mailbox role - this role hosts user mailboxes stored in databases that can
be replicated or clustered.
• Hub Transport role – this role provides internal routing of all messages –
from Edge servers, Unified Messaging (UM) servers, or between two users
on the same mailbox database. The Hub Transport role is also where
messaging policy is enforced for messages moving within and outside the
organization.
• Unified Messaging role – this role enables PBX integration to allow voice
mail and fax messages to be delivered to Exchange mailboxes, and provides
voice dial-in capabilities to Microsoft Exchange Server.
• Edge Transport role - this server resides outside your internal network
and provides on-premise e-mail security, antivirus, and anti-spam services
for Microsoft Exchange Server.
With the exception of the Edge Transport role, multiple roles or all roles can be
installed on a single system. This is because an Exchange server running the Edge
Transport role in a perimeter network (DMZ) is not a member of Active Directory or the
Exchange organization for security reasons. Another role limitation: clustered mailbox
servers can only be configured with the Mailbox server role.
Acronis Recovery for MS Exchange allows backing up of the Mailbox role only. See
section 5.3 for detailed instructions.

5.1.5 Storage Groups and Information Stores
Exchange Server 2007 Enterprise Edition supports up to 50 storage groups and 50
databases per server. You can configure up to five databases per storage group, and
up to a maximum of 50 databases. Now mailbox data can be distributed across more
databases, and mailbox databases can be distributed across more storage groups, than
in earlier versions of Exchange Server. Exchange Server Standard Edition supports up
to five storage groups and five databases per server. Both Enterprise Edition and
Standard Edition have an unlimited database size limit.
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Thus, an individual database in Microsoft Exchange is only a dependent part of a
storage group, and backing it up separately becomes pointless, because it does not
guarantee a data integrity after restoring.

5.1.6 Circular Logging
The Microsoft Windows 2000 Active Directory service and the Microsoft Windows
Server 2003 Active Directory service use the circular logging feature to maintain
transactions in the database file (Ntds.dit). The log files are maintained until the data
that they contain is written to the database file. The circular logging feature uses these
log files to recover transactions if the database file is shut down in an inconsistent
state. For example, a power failure or a Stop error can cause a transaction failure. In
Windows 2000 and in Windows Server 2003, there is currently no way to disable the
circular logging feature.

5.1.7 Disaster Recovery Plan
With Acronis Recovery for MS Exchange you can create a Disaster Recovery Plan. This
plan provides all the necessary information about the Microsoft Exchange server in the
form of step-by-step instructions for restoring the entire server in case of failure, a
disaster, or data corruption.
With the Disaster Recovery Plan any person, even non-DBAs, will be able to restore the
system in the shortest possible time. Such a plan also helps to reduce unexpected
issues during the recovery of the Exchange server.
It is recommended that you update and test the disaster recovery plan from time to
time. Doing so will ensure that the company’s staff is prepared, acts efficiently, and
feels practiced in the process of recovering lost or corrupted data.
See Chapter 6 “Disaster Recovery Plan” to learn how Acronis Recovery for MS
Exchange can help you generate the disaster recovery plan.

34

5.1.8 Continuous Data Protection
Continuous data protection (CDP, but also may be called continuous backup)
technology makes it possible to save data changes automatically and uninterruptedly,
restoring your data to its exact state at the moment of failure.
When you choose CDP technology during the creation of a backup task, you will have
to schedule only full backups. Acronis Recovery for MS Exchange controls folders with
archived logs and backs up all new logs into a CDP archive. A CDP archive contains a
set of full backups and an archive log, created after the last full backup. As a result,
you can restore data back to the last full backup, or to previously created archived log
backups, stored in the CDP archive.
When a new full backup is created, CDP logs will be truncated.
Please note, before starting any restore process, a CDP task must be stopped.
In case of restoring a whole database, a full backup must be created right
after the restoration process to protect your data.
A CDP task is processed in two ways: in a common task script and in a registry. The
registry’s format is known only by CDP service (CDP agent). Thus, to change or delete
CDP task from Acronis Recovery for MS Exchange Management Console, you also need
a CDP service started.
Note, CDP technology cannot be used while backing up to tapes and FTP.

5.1.9 Backing up to Tape Libraries and Tape Drives
Acronis Recovery for MS Exchange supports tape libraries, autoloaders and SCSI tape
drives as storage devices.

Backing up to Tape Drives
SCSI tape drives are accessible both remotely using the Acronis ® Backup Server
(shipped with Acronis True Image Echo Enterprise Server) and locally when they are
connected to the computer where Microsoft Exchange Server is being backed up.
The locally connected tape drive will appear in the list of backup destination devices
along with other available drives.
To enable backup to a locally attached tape device with Acronis Recovery for MS
Exchange:
1. Attach the tape device to the computer.
2. Move cartridges from the Unrecognized or Import media pool to the Free pool
using the Removable storage snap-in (Control panel -> Administrative tools ->
Computer management -> Removable storage -> Media pools.)
3. If the tape contains data, its contents will be overwritten on prompt.
4. When creating a backup task, you will be able to select the tape device from the list
of destination devices.
5. For tape drives: As soon as the tape is full, a dialog window with a request to insert
a new tape will appear.
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For tape library or autoloader: As soon as the tape is full, the program automatically
draws a tape from the Free or Import media pool. The above request will appear if
no tapes are found in either of these pools (see next section for details).
Backup and restore operations on a tape drive proceed in the same way as with other
devices with the following exceptions.
1. You do not have to provide filenames for backups.
2. As soon as the tape is full and the Acronis Recovery for MS Exchange
Management Console is connected to the computer, a dialog window with a
request to insert a new cartridge will appear.
3. If the tape already contains data, but is not full, new contents will be
appended.
You may experience short pauses when the tape rewinds. A low-quality and
old tape, or dirt on the magnetic head, may lead to pauses that can last up to
several minutes.
Acronis Recovery for MS Exchange can back up to remote tape drives when using
Acronis Backup Server (shipped with Acronis True Image Echo Enterprise Server).

Backing up to Tape Libraries and Autoloaders
A tape library is a high-capacity storage device consisting of one or more tape drives
and a loader, which automatically selects and loads multiple tape cartridges identified
with barcodes. Tape libraries having one drive and a loader are known as autoloaders.
Tape libraries are widely used as an efficient repository for long-term stored archival
data. Once the tape library is full, old data is progressively overwritten by new data.
With tape library support, Acronis Recovery for MS Exchange can store several backup
chains from different machines.
Please note, brick-level incremental backup cannot be created if use tapes as a backup
location.

5.2 Backing up Databases
To restore lost data or roll back Microsoft Exchange Server databases to a certain
state, you must first create a backup file. The Backup Information Stores wizard
allows you to schedule the creation of archives and set the required options.
Before you create a first full database backup, it is recommended to verify
database consistency. Dismount and then remount the database. Successful
mount ensures that the database is in a consistent state.
To launch the wizard, click on the backup operation icon in the main workspace.
You can use <Alt>+<N> to go to the next page and <Alt>+<B> to go to the
previous page of any Acronis Recovery for MS Exchange wizard.

5.2.1 Defining a Backup Strategy
In the first step of the Create a Backup wizard you will define the backup strategy.
Acronis Recovery for MS Exchange provides four ways to define the strategy:
•

Schedule a backup task with Acronis Recovery for MS Exchange Assistant
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•

Schedule a backup task manually

•

Use continuous data protection technology

•

Create a backup now

If you are not sure which backup strategy to choose, use Schedule a backup task
with Acronis Recovery for MS Exchange Assistant (selected by default). See
5.2.5 for details.
If you know which backup type to use for your data, select the Schedule a backup
task manually option. In this case you will have to define backup types and schedule
parameters for backup tasks.
Select Use continuous data protection technology option to enable CDP. In this
case you will have to schedule your full backups. See section 5.1.8 for more details.
To immediately run a backup task once select the Create a Backup Now option. A
full backup will be created.
While creating a backup task, you have to select, which way to back up your data.
Note, transaction logs files require considerable disk space, so you will have to delete
(or move to another place for storing) them manually, taking into account which files
are safe to remove.
For more information about backup types see 5.1.2 “Backup Types”.

5.2.2 Specifying a Task Execution Account
In this step of the Backup Information Store wizard you specify an account that is
valid for the computer housing databases you want to back up – task execution
account. These credentials will be used during each task execution for connecting to
the server and by default for connecting to the Microsoft Exchange Server.
The task will run as if it was started by the specified user.
Note, the task execution account also must have an existing mailbox in the current
Microsoft Exchange server to be able to correctly perform the backup operation.
Enter the user name and password, then click Next. Note, the domain name must also
be specified if the user is a member of a domain.
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Note, this step will be skipped if in the first one you selected the Create a
backup now option.

5.2.3 Selecting Items to Back Up
In this step of the wizard you have to specify which items to back up.
In the left pane of the window select an information store with Microsoft Exchange
installed and expand it to view and specify storage groups to back up. In case an
information store is selected, all associated storage groups will also be selected.
Information on the selected item is displayed in the right pane of the window:
information store name, installed operating system and the number of storage groups.
In case you are using Microsoft Exchange Server 2007, make sure the latest
versions of Microsoft Messaging API and Collaboration Data Objects 1.2.1 are
installed.
Important: Starting with Exchange 2007, neither the MAPI client libraries nor
CDO 1.2.1 are provided as a part of the base product installation, but
distributed as a Web download.
Visit Microsoft website:
http://www.microsoft.com/downloads/details.aspx?FamilyID=94274318-27c44d8d-9bc5-3e6484286b1f&DisplayLang=en
Note, this version of the package is now compatible with Windows Vista and
Windows Server 2008.
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Selecting Information Stores to Back Up
When selecting an information store to back up Acronis Recovery for MS Exchange will
automatically back up all of the storage groups associated with this information store.
A list of information stores can be obtained, with the connected user’s
privileges that cannot be changed.
Note, Acronis Recovery for MS Exchange does not back up the Active
Directory. This means, that even there were any changes after a backup
archive was created, after restoring the Microsoft Exchange Server structure
will remain the same as it was before the restoration process. As a result,
while restoring information stores, only storage groups will be restored one by
one. For example, mailboxes created or deleted after the last backup, will still
exist phisically after the restore, but they will not be mounted, and so will not
be usable.
Though Acronis Recovery for MS Exchange allows backing up and further
restoring of separate users accounts (see section 8.4.3 “User Account
Ownership”).
The right pane will display the information store name, Microsoft Exchange version, the
installed operating system and amount of storage groups.

Selecting Storage Groups to Back Up
Select the specific storage group you want to back up. The right pane will display its
name, size, number and total size of associated databases, as well as circular logging
status (enabled/disabled).
Please note, Microsoft Exchange Server does not delete e-mails immediately,
but only marks them as deleted. In this way such e-mails can also be included
into the archive.
After selecting the appropriate object for back up, click Next to continue.
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5.2.4 Selecting a Backup Archive Location
Acronis Recovery for MS Exchange supports the following places and media for backup
destinations:
•

Local HDD

•

Network shares, SAN, NAS

•

FTP

•

Tape drives, Autoloaders, Tape libraries

•

Acronis Backup Server (shipped with Acronis True Image Echo™ Enterprise
Server)

Acronis Backup Server
This software application, when installed on a networked computer,
automatically manages backup archives and retention policies for the
specified location and ensures optimal usage of storage space. Outdated
archives will automatically be deleted as specified in the retention policies set
by the administrator. In addition, Acronis Backup Server facilitates the
creation and execution of group backup tasks.
Acronis Backup Server is shipped with Acronis True Image Echo Enterprise
Server.
We recommend you store the archives for each task in separate locations to avoid
confusion during recovery.
Note, the further you store the backup archive from the original location, the safer it
will be in case of data damage. For example, saving the archive to another hard disk
will protect your data if the primary disk is damaged. Data saved to a network disk or
backup server will survive even if all your local hard disks are down.
Select the desired archive location from the folders tree or specify a backup location in
the Folder field.
In case you have chosen an ftp server as a backup location, provide login and
password for this server in a special pop-up window which appears after you select this
item from the tree.
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Important! Do not enter the login and password in the Folder
(“ftp://login:password@ftpserver”); the product will not process this command.

field

Acronis Recovery for MS Exchange guarantees the integrity of the backup
chain only in a separate archive. Thus, creation of a new archive will start a
new chain of backups. Acronis Recovery for MS Exchange behavior does not
depend on what you want to back up (the entire information store or only a
separate storage group). By default, transaction logs are truncated before
creating such a chain to decrease the archive size and duration of the backup
operation. You can change this behavior by specifying additional settings in
backup options (see 5.4.7 for detailed information).
Please note that unsupported Acronis Backup Server versions will not be
displayed in the Acronis Backup Servers list. To provide compatibility with
Acronis Recovery for MS Exchange, please install most up-to-date version,
available at: http://www.acronis.com/enterprise/products/ATIES/backupserver.html .

Note, Acronis Recovery for MS Exchange does not display mapped network
drives in the Folders tree.

Acronis Recovery for MS Exchange allows you to clean storage places to avoid storing
out of date archives. See Chapter 7 “Backup Location Clean-up” for details.

5.2.5 Using Acronis Recovery for MS Exchange Assistant
Acronis Recovery for MS Exchange Assistant will help you define backup strategy and
creation parameters. You will be prompted to answer a few questions, and Acronis
Recovery for MS Exchange Assistant will choose and schedule the appropriate backup
type for protecting your company’s databases from loss or damage (see a table of
backup strategies at the end of this chapter).

Performance
Decide what is most important to your operation – a strategy that requires less storage
space or faster data recovery.
Select an option:
•

Quick backup and smaller backup archives - backups are created fast
and occupy less space, but recovery process requires more time. This
option is set by default.

•

Quick recovery but backups require more storage space – recovery
process is faster, though backups will take more time to be created and
occupy more disk space in comparison to a quick backup.
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Click Next to continue.

Acceptable Data Loss
At this step specify a period of time when data changes significantly. This will help
Acronis Recovery for MS Exchange Assistant define the schedule for backup creation –
how often to run the backup operation and which backup type to choose.
Select one of the following options:
•

Hour – select this option if you want to back up the selected data hourly

•

Day - select this option if you want to back up the selected data daily

Click Next to continue.

Server Load During a Week
Specify the workload distribution on the Exchange server during a week. The Assistant
will use this information to define a backup schedule according to your company’s
server’s load. The load information is used to determine when and what type of
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backups to create to avoid data loss (backup creation frequency), as well as when to
execute the operation.
In the table there are three rows representing three levels of load (High, Medium and
Low), and seven columns representing the days of the week.
By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value for a certain day, click the appropriate cell.

Click Next to continue.

Server Load During a Day
Specify workload distribution on the Exchange server throughout the day. As in the
previous step, this information will help to define a backup schedule that complements
the peaks and valleys of your company’s server loads.
In the table there are three rows representing three levels of load (High, Medium and
Low), and 24 columns representing the hours of the day.
By default the most widely used pattern is specified (selected cells are highlighted in
blue). To change the value of a particular hour, click the appropriate cell.
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Initial Task Starting
Specify a time for applying the selected scheme:
•

Now – select this option to execute the scheduled task immediately after
you finish the wizard

•

On the specified date and time – the selected scheme will be applied on
the specified date. Note that if there is no full backup when the first
incremental backup is to be performed, a full backup will be performed
independently of the actual date on which it is scheduled. You may consider
setting this date on the day of the week when your server load is not high

Click Next to view (and change if necessary) the schedule for backup tasks, created
by Acronis Recovery for MS Exchange Assistant.
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Table of Backup Strategies
The table below describes different backup strategies according to your requirements
for storage space and speed. The final strategy created by Acronis Recovery for MS
Exchange Assistant will be displayed in a Schedule page (see 5.2.6 for details).
Performance
Data change
rate

Hour
Day

Backup Type

Quick backup
and sm aller
archive size

Quick
recovery and
large archive
size

Full

Week

Day

Incremental

1 hour

1 hour

Full

Week

Day

Incremental

12 hours

12 hours

5.2.6 Setting Backup Scheduling Parameters
If you used Acronis Recovery for MS Exchange Assistant, it will create a schedule for
the choices you made. Click Edit to change the existing schedule settings.
If you decided to define the backup strategy manually, you have to set a schedule for
each backup type. See Chapter 9 “Scheduling Tasks” for detailed information.
Click Add to add new schedule settings for the appropriate type (full or transaction
logs). Clicking Delete will allow you to delete the existing schedule settings.
All the settings you made are displayed in the Result field at the bottom of the
window. To save your settings, click OK.
To quit task scheduling without saving, click Cancel.
Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you should not only backup your data once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation scheduled.

5.2.7 Backup Options
Select the backup options (pre/post commands, compression level etc.). You may Use
default options (see 5.4 for detailed information about backup options) or Set the
options manually. If you set the options manually, the settings will only be applied
to the current backup task.
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5.2.8 Specifying a Task Name and Providing Comments
On the Task Name and Archive Comments wizard page, you can provide a name
and comments for the backup task.
Enter a task name in the Task Name field to identify and organize tasks by operation
(edit, delete, etc.).
You may provide comments for the archives you create. The backup file size and
creation date are automatically appended to the description, so you do not need to
enter this information.

5.2.9 Backup Summary
The final stage of the backup is the summary window, which displays the list of
operations to be performed.
Click Finish to save the created schedule or start the backup creation task
immediately. You will be redirected to the Task List automatically, where you can view
and edit created tasks.
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5.3 Backing up Mailboxes
Brick-level (document level) backup is the most flexible type of backup. It offers
advanced configuration options and performs backups at folder levels and quick
restoring at separate messages level, allowing the most accurate level of restore. It
also supports advanced filtering during backup.
Use Mailbox backup and restore when you want the flexibility to back up individual
mailboxes, public folders and use mail level filters.
Also you can restore mailboxes and even separate e-mails from database backups.

5.3.1 Defining a Backup Strategy
In the first step of the Back up Mailboxes wizard you will define the backup strategy.
Acronis Recovery for MS Exchange provides three ways to define the strategy:
•

Schedule a backup task with Acronis Recovery for MS Exchange Assistant

•

Schedule a backup task manually

•

Create a backup now
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If you are not sure which backup strategy to choose, use Schedule a backup task
with Acronis Recovery for MS Exchange Assistant (selected by default). See
5.2.5 for details.
If you know which backup type to use for your data, select the Schedule a backup
task manually option. In this case you will have to define backup types and schedule
parameters for backup tasks.
To immediately run a backup task once select the Create a Backup Now option. In
this case a full backup will be created.
For more information about backup types see 5.1.2 “Backup Types”.

5.3.2 Specifying a Task Execution Account
In this step of the Create a Backup wizard you specify an account that is valid for the
computer housing Mailboxes you want to backup – task execution account. These
credentials will be used during each task execution for connecting to the server and by
default for connecting to the Microsoft Exchange.
The task would run as if it was started by the specified user.
Note, the task execution account also must have an existing mailbox in the current
Microsoft Exchange server to be able to correctly perform the backup operation.
Enter the user name and password, then click Next. Note, the domain name must also
be specified if the user is a member of a domain.
Note, this step will be skipped if you selected the Create a Backup Now in
the previous step (5.3.1 Defining a Backup Strategy).

5.3.3 Selecting Items to Back Up
In this step of the wizard you have to specify which items to backup: mailboxes and/or
public folders. Select an information store, the required storage group, then expand it
to view its mailboxes and public folders. In case an information store is selected, all
associated storage groups will also be selected.
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Information on the selected item is displayed in the right pane of the window:
information store name, installed operating system and the number of storage groups.

Selecting Mailboxes to Back Up
Choose a storage group and mailbox store from which you want to back up a mailbox.
Information (size and number of mailboxes) about the selected items will be displayed
on the right.
In the list, specify the mailbox (or separate folders) you want to back up. Information
about size, number of folders and subfolders, as well as the total number of e-mails
will be displayed on the right.
A list of information stores can be obtained, with the connected user’s
privileges that cannot be changed.

Selecting Public Folders to Back Up
Choose a storage group, public folder store and public folder from which you want to
back up a specific folder. Information about the selected items will be displayed on the
right.
In the list, specify the public folder you want to back up. Information about the size,
number of folders and subfolders, as well as the total number of e-mails will be
displayed on the right.
After selecting the appropriate object for back up, click Next to continue.

5.3.4 Excluding Objects
In this step the Backup wizard specify objects you want to exclude from the backup
archive to be created.
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Select Exclude the following objects from the backup to enable excluding
options and then select the required ones:
•

“Deleted Items” folder – exclude the “Deleted Items” folder from the
backup file to be created

•

“Sent Items” folder – exclude the “Sent Items” folder from the backup
file to be created

•

Items that were modified before – select day, month and year to
exclude objects modified earlier than the chosen date

•

Attachments larger than – select this item and specify the maximum
attachment size to be included into the backup file

•

The following types of attached files – select this item to exclude
attachments with files of the types listed below. Also you can change the list
of file types by clicking Specify types of files to exclude and delete or
add the required ones. Note, you can enter several file extensions under one
name by separating them with commas.
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5.3.5 Selecting a Backup Archive Location
Acronis Recovery for MS Exchange supports the following places and media for backup
destinations:
•

Local HDD

•

Network shares, SAN, NAS

•

FTP

•

Tape drives, Autoloaders, Tape libraries

•

Acronis Backup Server (shipped with Acronis True Image Echo™ Enterprise
Server)

We recommend that you store the archives of each task in a separate location to avoid
confusion during recovery.
Note, the further you store the backup archive from the original location, the safer it
will be in case of data damage. For example, saving the archive to another hard disk
will protect your data if the primary disk is damaged. Data saved to a network disk or
backup server will survive even if all your local hard disks are down.
Select the desired archive location from the folders tree or specify a backup location in
the Folder field.
In case you have chosen an ftp server as a backup location, provide a login and
password for this server in a special pop-up window which appears after you select this
item from the tree.
Important! Do not enter the login and password in the Folder
(“ftp://login:password@ftpserver”), the product will not process this command.

field
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Acronis Backup Server
This software application, when installed on a networked computer,
automatically manages backup archives and retention policies for the
specified location and ensures optimal usage of storage space. Outdated
archives will automatically be deleted as specified in the retention policies set
by the administrator. In addition, Acronis Backup Server facilitates the
creation and execution of group backup tasks.
Acronis Backup Server is shipped with Acronis True Image Echo Enterprise
Server.
Select the desired archive location from the folders tree or specify a backup location in
the Folder field.
Acronis Recovery for MS Exchange guarantees the integrity of the backup
chain only in a separate archive. Thus, creation of a new archive will start a
new chain of backups.
Please note that unsupported Acronis Backup Server versions will not be
displayed in the Acronis Backup Servers list. To provide compatibility with
Acronis Recovery for MS Exchange, please install the up-to-date version,
available at: http://www.acronis.com/enterprise/download/ATIBS .

Note, Acronis Recovery for MS Exchange does not display mapped network
drives in the Folders tree.
Acronis Recovery for MS Exchange allows you to clean storage places to avoid storing
out of date archives. See Chapter 7 “Backup Location Clean-up” for details.

5.3.6 Using Acronis Recovery for MS Exchange Assistant
Acronis Recovery for MS Exchange Assistant will help you with define backup strategy
and creation parameters. See section 5.2.5 for detailed information on using Acronis
Recovery for MS Exchange Assistant.

5.3.7 Setting Backup Scheduling Parameters
If you used Acronis Recovery for MS Exchange Assistant, Acronis Recovery for MS
Exchange will offer the appropriate schedule for the choices you made. Click Edit to
change existing schedule settings.
If you decided to define the backup strategy manually, you have to set a schedule for
each backup type. See Chapter 9 “Scheduling Tasks” for detailed information.
Click Add to add new schedule settings for the appropriate type (full or transaction
logs). Clicking Delete will allow you to delete the existing schedule settings.
All the settings you made are displayed in the Result field at the bottom of the
window. To save your settings, click OK.
To quit task scheduling without saving, click Cancel.
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Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you should not only backup your data once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to schedule
the necessary operation.

5.3.8 Backup Options
Select the backup options (pre/post commands, compression level etc.). You may Use
default options (see 5.4 for detailed information about backup options) or Set the
options manually. If you set the options manually, the settings will only be applied
to the current backup task.

5.3.9 Specifying a Task Name and Providing Comments
On the Task Name and Archive Comments wizard page, you can provide a name
and comments for the backup task.
Enter a task name in the Task Name field to identify and organize tasks by operation
(edit, delete, etc.).
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You may provide comments for the archives you create. The backup file size and
creation date are automatically appended to the description, so you do not need to
enter them.

5.3.10 Backup Summary
The final stage of the backup is the summary window, which displays the list of
operations to be performed.
Click Finish to save the created schedule or start the backup creation task
immediately. You will be redirected to the Task List automatically, where you can view
and edit created tasks.

5.4 Setting Default Backup Options
Acronis Recovery for MS Exchange lets you set the backup options you want to use as
default for future tasks.
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To edit the default backup options, select Tools -> Options from the main program
menu.
You will also still be able to edit the backup options while creating a backup task.

5.4.1 Pre/Post Commands
You can specify commands (or even batch files) that will be automatically executed
before and after the backup procedure. For example, you may want to start/stop
certain Windows processes, or check your data before starting the backup operation.
You can use commands set by default, as well as specify your own commands.
Select Use commands, type commands manually or click Edit to configure the
command:
• Select commands to be executed before the backup process starts in the
Before backup process field. To create a new command or select a new
batch file click the Edit button.
• Select the command to be executed after the backup process ends in the
After backup process field. To create a new command or select a new
batch file click the Edit button.
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5.4.2 Compression Level
Select the compression level for the backup. With higher compression ratios the
archive file size will be smaller, but the backup process may take longer.
You can choose one of the compression levels for a backup archive:
• None - the data will be copied without any compression
• Normal - the recommended data compression level (set by default)
• High - higher archive compression level
• Maximum - maximum backup archive compression
• Ultimate – ultimate level of compression
Generally, it is recommended to use the default Normal compression level. You might
want to select Maximum compression so the backup archive occupies less storage
space.
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5.4.3 Backup Priority
You can set up the backup process priority:
• Low - the backup process will run slower, but it will not influence other
processes running on your computer
• Normal - the backup process will run with normal priority
• High - the backup process will run faster, but it may influence other
processes running on your computer
Changing the priority of a backup process can make it run faster or slower, but it can
also adversely affect the performance of other programs running simultaneously. The
priority of any process running in the system determines the amount of CPU usage and
system resources allocated to that process. Decreasing the backup priority will increase
the number of compute cycles available to other processes.

5.4.4 Backup Protection
Password
The preset is No Password.
You can password protect your archives so that they will be inaccessible to others.
Enter a password in the text field and confirm it. The password is case sensitive.
Please keep in mind that in the Restore Data wizard, Acronis Recovery for MS
Exchange will ask for a password after you select a folder within the archive location.
Only those archives that were protected with the password you typed in or non
password-protected archives will be displayed. Best practices suggest using the same
password for backup archives in the same folder within the archive location.

Encryption
After setting a password, you can choose to encrypt the backup with an industrystandard AES cryptographic algorithm for advanced security.
To set up backup encryption, select one of the following encryption types:
•

None – backups will not be encrypted
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•

AES 128 – the quickest encryption method available (set by default)

•

AES 192 – encryption will take longer than 128-bit, but is more secure

•

AES 256 – requires the most amount of time to cipher, but it is also the
most secure setting available

5.4.5 Backup Type Substitution
You need to create full backup of data before creating an incremental one. If for some
reason a full backup does not exist, you will need to create a full backup independently
of the backup strategy you have configured.
Specify the schedule of creating backups so that a full backup will be created first (see
Chapter 9 “Scheduling Tasks” for detailed information), or select the check box If
creation of a selected type of backup failed, try to create a full backup.
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5.4.6 Bandwidth Throttling
You can limit the bandwidth used by the backup process so that network resources will
be available for other processes.
To set the desired data transfer speed, check the Enable bandwidth throttling
parameter. Select a maximum bandwidth value from the drop-down list or enter a
value manually.

5.4.7 Additional Settings
1. Validate backup once it has been created
When enabled, the program will verify the integrity of the archive immediately after it
is created.
To validate the archive data integrity you must have all of the backups in the
series (full and incremental backups) available in the same location. If any of
the successive backups are missing, validation will not be possible.
2. Backup metadata
This parameter is selected by default, which allows backing up metadata.
3. Overwrite data on the tape
Select this parameter if you use tapes as a backup location and want to choose an
overwrite mode. See 5.1.9 for detailed information.
4. Fast incremental backup
Select this parameter to create only brick-level (mailbox level) backup, which provides
quicker restoring of individual e-mails and mailboxes. The backup process will run
faster because Acronis Recovery for MS Exchange will not detect items deleted since a
full backup was created, but will back up only new or changed items.
5. Do not truncate logs
This parameter is available only while backing up information stores/storage groups
and is disabled by default.
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It will be enabled only if you create independent full backups (Acronis Recovery for MS
Exchange will check the specified backup strategy).
In all other cases Acronis Recovery for MS Exchange will truncate transaction logs,
since creating an archive chain (full and incremental backups) is impossible with
transaction logs not truncated after the first full backup.
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Chapter 6. Disaster Recovery Plan

It is extremely important for all organizations and users to have detailed instructions
describing the process for recovering data quickly and efficiently in case of disaster – a
Disaster Recovery Plan. This plan should contain all of the required information to
guide someone through the recovery process. When creating a Disaster Recovery Plan,
be sure to include scenarios and procedures for different kinds of disaster situations
(loss of the Exchange server, data corruption, complete loss of storage groups etc).
The Disaster Recovery Plan should include step-by-step instructions for every possible
type of disaster, as well as each server’s hardware and software configuration.
With the Create Disaster Recovery Plan wizard, you can generate and view a
Disaster Recovery Plan for your database server immediately, or schedule to receive it
via e-mail after each update.

6.1 Viewing a Disaster Recovery Plan Immediately
Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.
1. In the first step of the wizard, choose the View the Disaster Recovery
Plan for the selected database option to generate and view the Disaster
Recovery Plan for the selected databases immediately
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2. Select the items you want to obtain the Disaster Recovery Plan for

3. Choose whether you want to receive the Disaster Recovery Plan by e-mail
or to view it in HTML format
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4. If in the previous step you selected to receive the Disaster Recovery Plan by
e-mail, you will need to specify the e-mail parameters
Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-mail
addresses separating them by commas
A Username and a password may also be needed if the SMTP server
requires authentication.
You can check if the settings are correct by clicking the Send test E-Mail
message button

5. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window, which display the list of operations to be performed.
Click Finish to obtain the Disaster Recovery Plan immediately.
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In the latter case an e-mail will be sent to the address you specified or a
HTML version of the Disaster Recovery Plan will be opened in your web
browser after you click Finish.

6.2 Scheduling Receipt of the Disaster Recovery Plan
Launch the Disaster Recovery Plan Creation wizard by clicking on the Disaster
Recovery Plan operation icon in the main workspace.
1. In the first step of the wizard, use the Define databases for which you
want to receive the plan each time it is updated option to choose
which items to generate the Disaster Recovery Plan for each time any
changes occur. The updated version of the plan will automatically be sent to
e-mail addresses you specify.

2. Select the databases for which you want to obtain the Disaster Recovery
Plan.
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3. Specify the e-mail account that will be used for sending the Disaster
Recovery Plan. Provide the e-mail address to which the plan will be sent
and the outgoing SMTP server name. You can specify several e-mail
addresses separating them with commas.
A Username and a password may also be needed if the SMTP server
requires authentication.
You can check if the settings are correct by clicking the Send test E-Mail
message button.

4. The final stage of the Disaster Recovery Plan Creation wizard is the
summary window which displays the list of operations to be performed.
Click Finish to schedule receipt of the Disaster Recovery Plan after each
update.
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6.3

Summary

Thus, in case of disaster, you only need to take the most recent version of the Disaster
Recovery Plan and follow the instructions to restore your databases.
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Chapter 7. Backup Location Clean-up

Sooner or later the backups you create will fill up the assigned storage space. Acronis
Recovery for MS Exchange allows you to clean up backup locations by specifying how
long to store the archive and/or the maximum number of full backups to store. By
default, these options are disabled.
Launch the Backup Location Clean-up wizard by clicking on the icon in the main
program window.

7.1 Specifying a Task Execution Account
In the first step of the Backup Location Clean-up wizard, you have to specify a local
or domain account which is valid on the computer where the archives are stored – a
task execution account. The specified account must have rights and permissions to
manage files in the backup location you want to clean up.
Enter the user name and password then click Next. The domain name must be
specified if the user is a member of a domain.
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7.2 Selecting the Backup Archive Location
Select the backup location you want to clean from the tree, or manually specify the
path to it in the Path field below the tree. You can also select Acronis backup locations
(such as Acronis Backup Server).
The following resources may also be selected for backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Acronis Backup Server

Important! The backup location clean-up operation will be performed for the
selected location and affect all database archives, created by Acronis Recovery
(even if these are archives for Microsoft Exchange, Microsoft SQL Server, or
Oracle).
Click Next to provide a password, if one is required, for archives in the selected
backup location.

7.3 Providing a Password
If there are any password-protected backup archives in the location you have selected
(see 7.2), you will need to enter the password to clean up the archive location.
Click Next to continue.

7.4 Specifying Cleaning Options
At this step specify the GFS or Simple (selected by default) scheme to use for location
cleaning.

7.4.1 GFS Scheme
Select this option to enable GFS clean-up scheme.
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GFS (Grandfather-Father-Son) scheme will keep three sets of backups in the selected
location. This scheme, if chosen, is activated on the day the first full backup was
created: all backup archives (full and incremental) for the current week (7 days
starting from the day of creating the first full backup); one full backup for each week
of the current month; and finally one full backup for each month of the current year.
In this scheme months and years calculation is based on a lunar calendar (cycles of the
moon phase), i.e. one month is 28 days, one year is 13 lunar months (364 days).
You may also specify notification receiving, if free space in the backup location is
lower, that the selected size (in GB). You will receive an e-mail, but no archives will be
deleted automatically. To specify e-mail parameters, go to the Tools  Options (see
11.1 “E-mail Notifications” for more details).

7.4.2 Simple Scheme
Select Use the simple scheme option to specify the following parameters:

Minimum free space
Select this parameter to check the remaining free space and to specify the minimum
size in GB. With this option selected, you will be able to specify the minimum number
of full backups to keep and the minimum lifetime of archives to store (in days).

Maximum number of full backups
Select the Remove the oldest archives if the total number of full backups is
more than check box and type or select the maximum number of full backup archives
to store.

Maximum archive’s lifetime
Select the Remove archives that are more than check box and type or select the
maximum number of days to store archives in the day(s) old box.
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7.5 Schedule Cleaning
Acronis Recovery for MS Exchange allows you to schedule backup location clean-up.
Specify the schedule that is the best for your needs (see Chapter 9 “Scheduling Tasks”
for detailed information).

7.6 Backup Location Clean-up Summary
The final stage of the backup location clean-up is the summary window, where the list
of operations that will be performed is displayed.
Click Finish to save the created schedule or start the backup location clean-up task
immediately.
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Chapter 8. Restoring the Backup Data

Acronis Recovery for MS Exchange restores storage groups and mailboxes from
previously created backup archives.

8.1 Restoring Information Stores
Launch the Restore Information Store wizard by clicking on the restore operation
icon in the main workspace.
For a successful restore operation on Windows SBS 2003, you will need to set write
permissions for the database folder after each update of Windows SBS 2003. Rightclick on a folder with database files, and select Properties. In foder properties, select
“Security -> Advanced, and in the window that opens check the “Replace permission
entries on all child objects with entries shown here that apply to child objects” item.

8.1.1 Restoration Time Selection
In the first step of the Restore Data wizard you will select when to run the
restoration process. There are two choices:
•

Now – select this option to execute the restore operation immediately after
you finish the wizard

•

On schedule – select this option to schedule the operation

•

When restoring on bare metal – this option is available if Acronis True
Image Echo Enterprise Server is installed and allows restoring the whole
production server on a bare metal (see section 2.3.2 for details)
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8.1.2 Specifying a Task Execution Account
In this step of the Restore Data wizard, you are specifying an account that is valid on
the computer where the data you want to restore is located – a task execution
account. These credentials will be used during each task execution for connecting to
the server.
The task will run as if it was started by a specified user.
Note, the task execution account also must have an existing mailbox in the current
Microsoft Exchange server to be able to correctly perform the restore operation.
Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain.

8.1.3 Selecting a Backup Location
Select the appropriate backup location in the tree or specify the path to it manually in
the Path field below the tree. Acronis Recovery for MS Exchange stores up to ten
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locations for the last archives created in a special folder – Recent Backup Locations
- so you can easily locate the appropriate archive.
You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Tapes, Autoloaders, Tape Libraries

•

Acronis Backup Server

The number of archives in the selected folder is displayed in the right pane.

Click Next to continue.

8.1.4 Selecting a Backup Task
If several backup tasks use the same location to store archives, you have to select the
task you want to restore from.
Note, Acronis Recovery for MS Exchange does not protect archives form
possible physical corruption. In case you try to restore data from the
corrupted archive, an error message will appear and the restore task will not
be executed. We recommend you to rename or delete the last archive’s slice
(since the corrupted one and all subsequent slices should be renamed or
deleted), and then try to execute the restore task once more.
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Click Next to continue.

8.1.5 Providing a Password
If there are any password-protected backup archives in the location you have selected
(see 8.1.3), you will need to enter the password to restore your data from the
archives.
Click Next to continue.

8.1.6 Restore Point Selection
Specify to which state you want to restore your data.
Acronis Recovery for MS Exchange offers four ways for restoring your data:
•

to the point of failure – the data will be restored to the state at the point
of failure. To be able to restore to the point of failure, a chain of backed up
logs and also newly created log files (including an active log) must be
available in the selected location. Otherwise only restoring to the time of
the latest backup is available. Keep in mind, that restoring to the point of
failure can take a long time.
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•

to the time of the latest backup – choosing this option will restore your
data to the state when the last backup was created. Restoring to the latest
backup will be faster, than restoration to the point of failure.

•

to a specific point in time - Acronis Recovery for MS Exchange allows
you to specify a date and time to restore your data from. Note, to be able
to restore to a specific point in time, Microsoft Exchange transaction logs
must be backed up. Data will be restored to the time of the last created
backup before the specified time, and then transaction logs will be applied.
In case logs, containing information about the specified point in time, are
not available (deleted or corrupted), the restore task will fail.

•

from the selected backup – select this option to choose a backup from
which to restore. A list of backups will be available by clicking on the Select
from the list of backups link. Choose the backup you want to restore
from and click OK.

To use special recovery modes, enable the corresponding parameter and select
Acronis Active Restore or Dial tone recovery.
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Select Acronis Active Restore to immediately obtain the access to the Microsoft
Exchange server. You also can restore public folders with this feature activated.
Another advantage is that Acronis Active Restore may be used with all versions of
Microsoft Exchange Server 2007 (see 8.5 for details).
Select Dial tone recovery in order to recover e-mail service in the first place, this will
enable users to send and receive e-mail while all other data is being restored. You can
use dial tone recovery only while restoring data from the latest backup. If you restore
storage groups using dial tone recovery feature, they will be re-created during the
restore process.
In case of restoring several storage groups using Dial tine recovery, they will be
restored and become available one by one.
Dial tone recovery may be used only with Microsoft Exchange Server 2007 (see 8.5 for
details).
Restart an e-mail application after the restoration process is completed to bring data to
up-to-date state.
To overwrite previously created dial tone databases generated by third-party tools,
select the corresponding check box. This step eliminates the need to delete the old
databases manually.

After selecting the appropriate option click Next to continue.

8.1.7 Content Selection
Acronis Recovery for MS Exchange restores information stores and separate storage
groups. Select a database server from the tree in the left pane.

Restoring Information Stores
Choose an information store to restore. Information about this item will be displayed
on the right. Please consider, that it is possible to restore only items of mailboxes level
from a database level archive. Thus, to restore a whole database, select all mailboxes
in the left pane.
Note, only databases, which existed before creating a full backup, will be displayed.
Newly created databases cannot be restored only from storage groups’ transaction
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logs. In terms of this, we recommend you to create full backups after new databases
are created.
Important! While restoring an information store, e-mail service will not be
available, i.e. users will not be able to send and receive e-mails.

Restoring Storage Groups
Choose the storage group to restore.
You can restore storage groups to its original location, choose another storage group
as a new location or restore to Recovery Storage Group (in this case only one storage
group can be restored).
Important! After a successful completion of a database restore process, the
database will remain in dismounted. One of the possible ways to avoid this
situation is increasing permission privileges for the database being restored.
For more details please visit http://support.microsoft.com/kb/827283.

Click Next to continue.

8.1.8 Restore Options
Select the options for the restoration process (Pre/Post commands, restoration process
priority etc.). You can Use default options (See 8.4 “Setting Default Restore
Options” for more information.) or Set the options manually. In the latter case, the
settings will be applied only to the current restore task.
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8.1.9 Selecting Start Parameters
You can run a restore task manually or specify the frequency (Daily, Weekly or
Monthly). See Chapter 9 “Scheduling Tasks” for detailed information.

8.1.10

Echo Task Selection

When restoring on bare metal, you need to select the Acronis True Image Echo
Enterprise Server task responsible for the restoration of system volumes and volumes
where Microsoft Exchange Server is located. You can do it either immediately after
Restore Data wizard completes or do it manually later.
Choose one of the following actions:
•

Do not run Echo task - in this case, you will have to select Acronis True
Image Echo Enterprise Server task manually later.

•

Run the following Echo task - in this case, you have to select Acronis
True Image Echo Enterprise Server task from the list below. The selected
task will be started immediately after Restore Data wizard completion.

Having selected the appropriate action, click Next to continue.

8.1.11

Restore Summary

In the final step, the restoration summary is displayed. Up to this point, you can click
Back to make changes in the created task.
If you click Cancel, no databases will be restored.
Important! Clear the Microsoft Outlook cache after the restore operation
completion for the correct data representation.
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Click Finish to save the schedule or start the restore task immediately.

8.2 Restoring Mailboxes
Launch the Restore Mailboxes wizard by clicking on the restore operation icon in the
main workspace.

8.2.1 Restoration Time Selection
In the first step of the Restore Data wizard you decide when to run the restoration
process. There are two choices:
•

Now – select this option to execute the restore operation immediately after
you finish the wizard

•

On schedule – select this option to schedule the operation
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8.2.2 Specifying a Task Execution Account
In this step of the Restore Data wizard, specify an account that is valid on the
computer where the backup archives you want to restore are located – a task
execution account. These credentials will be used during each task execution for
connecting to the server and for connecting to the Microsoft Exchange.
Thus, the task will run as if it was started by the specified user.
Note, the task execution account also must have an existing mailbox in the current
Microsoft Exchange server to be able to correctly perform the restore operation.
Enter the Username and password then click Next. The domain name must be
specified if the user is a member of a domain.

8.2.3 Selecting a Backup Location
Select the appropriate backup location in the tree or specify the path to it manually in
the Path field below the tree.
You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Tapes, Autoloaders, Tape Libraries

•

Acronis Backup Server

The number of archives in the selected folder is displayed in the right pane.

Click Next to continue.

8.2.4 Selecting a Backup Task
If several backup tasks use the same location to store archives, you have to select the
task you want to restore from.
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Note, Acronis Recovery for MS Exchange does not protect archives form
possible physical corruption. In case you try to restore data from the
corrupted archive, an error message will appear and the restore task will not
be executed. We recommend you to rename or delete the last archive’s slice
(since the corrupted one and all subsequent slices should be renamed or
deleted), and then try to execute the restore task once more.
While restoring, an archive tree will be mounted into C:\Documents and Settings\All
Users\Application Data\Acronis\MountRestoreDir folder, but this mounting is required

for the restore process and does not take a disk space. The mounted tree represents
the structure of files and folders from the archive as a real folder on the disk to allow
third-party software to access databases files and logs.
Click Next to continue.

8.2.5 Providing a Password
If there are any password-protected backup archives in the location you have selected
(see 8.2.3), you will need to enter the password to restore your data from archives.
Click Next to continue.

8.2.6 Restore Point Selection
Specify to which state you want to restore your data.
Acronis Recovery for MS Exchange offers four ways for restoring your data:
•

to the time of the latest backup – choosing this option will restore your
data to the state when the last backup was created. So restoration to the
latest backup will be faster, than restoration to the point of failure.

•

from the specific backup – select this option to choose a backup from
which to restore. A list of backups will be available by clicking on the Select
from the list of backups link. Choose the backup you want to restore
from and click OK.
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After selecting the appropriate option click Next to continue.

8.2.7 Content Selection
Acronis Recovery for MS Exchange allows restoring mailboxes and separate public
folders. First, select a database server from the tree in the left pane.
Also Acronis Recovery for MS Exchange allows using a filter to display only the required
items in the tree. Type a word, which will help you to define the necessary folders, in
the Filter field.

Restoring Mailboxes
Choose a Storage Group and Mailbox Store from which you want to restore a mailbox.
Information (size and number of Mailboxes) about the selected items will be displayed
on the right.
In the drop-down list, specify the Mailbox (or separate folders) you want to restore.
Information about the size, number of folders and subfolder, as well as the total
number of e-mails will be displayed on the right.
You can restore mailboxes to their original location or choose another mailbox
database as a new location. In the latter case the Next button will be disabled until
you choose a mailbox to restore to.
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Restoring Public Folders
Choose a Storage Group, Public Folder Store and Public Folder from which you want to
restore a specific folder. Information about the selected items will be displayed on the
right.
In the drop-down list, specify the public folder you want to restore. Information about
size, number of folders and subfolders, as well as total number of e-mails will be
displayed on the right.
You can restore public folders to their original location or choose another folder as a
new location. In the latter case the Next button will be disabled until you choose a
public folder to restore to.
Administrator should recreate deleted users’ individual public folders with preexisting permissions before starting a restore process to restrict the access to
these folders during the restore. Otherwise, these individual public folders will
be restored with their parent folder’s permissions.
Please note, that e-mails and folders from non-MAPI public folders cannot be restored
using a brick-level restore.
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Click Next to continue.

8.2.8 Restore Options
Select the options for the restoration process (Pre/Post commands, restoration process
priority etc.). You can Use default options (See 8.4 “Setting Default Restore
Options” for more information.) or Set the options manually. If the latter is the
case, the settings will be applied only to the current restore task.

8.2.9 Selecting Start Parameters
You can run a restore task manually or specify the frequency (Daily, Weekly or
Monthly). See Chapter 9 “Scheduling Tasks” for detailed information.

8.2.10

Restore Summary

In the final step, the restoration summary is displayed. Up to this point, you can click
Back to make changes in the created task. If you click Cancel, no databases will be
restored.
Note, temporary files, created during the restore process, may require
considerable disk space. Hence, it is advisable to choose the appropriate
location for theses files.
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Click Finish to save the schedule or start the restore task immediately.

8.3 Restoring Individual E-mails
In addition to restoring storage groups and mailboxes, Acronis Recovery for MS
Exchange can restore individual e-mails.
Before performing an e-mails restore operation, make sure that remote
procedure call (RPC) over HTTP(s) support is installed and configured
correctly. This also concerns a mailbox restoring from a database level
backup.
For more information visit
http://technet.microsoft.com/en-us/library/aa997495(EXCHG.65).aspx
or
http://support.microsoft.com/Default.aspx?kbid=833401 .
Please pay attention to the difference in configuration for single Microsoft
Exchange/domain controller server and multi-server environment.
Start the e-mail restoration process by clicking on the restore operation icon in the
Tools group.

8.3.1 Selecting a Backup Location
To view available storage groups and mailboxes select the appropriate backup location
by clicking the Select location… link or specify the path to it manually in the Backup
location field.
You can also select specific Acronis backup locations (such as Acronis Backup Server).
The following resources may also be selected as backup locations:
•

Entire disk or disk folder

•

Network share, SAN, NAS

•

FTP

•

Tapes, Autoloaders, Tape Libraries

•

Acronis Backup Server
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8.3.2 Selecting a Backup Task and Point to Restore
If several backup tasks use the same location to store archives, you have to select the
task you want to restore from. Click the Select task… link to choose the backup task
and a point to restore e-mails to.
Please consider that if you choose a database level backup to restore e-mails from, it
will remain mounted and no changes to the archive (deleting files, restoring, etc.) will
be possible till you mount another archive or close the Management Console.
The left pane will display a list of available tasks. A selected task’s comments will be
displayed on the right.
Below you have to select to which state you want to restore e-mails.
Acronis Recovery for MS Exchange offers four ways for restoring your data:
•

to the time of the latest backup – choosing this option will restore your
e-mails to the state when the last backup was created. So restoration to the
latest backup will be faster, than restoration to the point of failure.

•

At the time of the selected backup – select this option to choose a
backup from which to restore. A list of backups will be available by clicking
on the Select from the list of backups link. Choose the backup you want
to restore from and click OK.
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After selecting the appropriate option click OK to return to the E-mail Restoration
window.

8.3.3 Setting Additional Search Options
Filter
Acronis Recovery for MS Exchange allows using a filter to display only the required
items in the tree. Type a word, which will help you to define the necessary folders, in
the Filter field. Only Mailboxes containing this word will be displayed in the tree
below.

Text to search
You can enter a text you want to search for in e-mails’ subjects in a corresponding field
and click the Search button. As a result, only e-mails whose subject contains that text
will be displayed below.

Advanced search options
Click the Advanced search options link to specify additional options for e-mail
searching:
• Search by person – select this option to specify e-mail addresses of a
sender and/or recipient
• Search by date – select this option to specify the period of time (From and
To) to search for required e-mail
• Search in – select this option to specify the following parameters:
o M essage header – Acronis Recovery for MS Exchange will search for the
required text only in messages’ headers
o M essages w ith attachm ents only – Acronis Recovery for MS Exchange
will search for the required text only in messages with attachments.
After setting the appropriate options click OK to return to the E-mail Restoration
window.
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Please note, only the first 100 e-mails will be shown in the table (see section 8.3.4).
So consider proper search options.

8.3.4 Selecting E-mail Exporting parameters
Select the way you want to export selected emails from the drop-down list before
starting the restoration process, and then click Restore:
• To original location – e-mails will be restored to their original location
(mailbox or public folder)
• Save to file – select the location where e-mails will be saved and choose a
type of the file (*.eml, *.msg) and click OK
• Send by e-mail – restored e-mails will be sent to specified addresses.
Provide e-mail addresses and the outgoing SMTP server name. A Username
and a password may also be needed if the SMTP server requires
authentication and click OK.
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8.4 Setting Default Restore Options
To view or edit the default restore options, select Tools -> Options -> Default
Restoration Options from the main program menu.
You can also edit restore options while creating a restore task.

8.4.1 Pre/Post Commands
You can specify commands or batch files to be automatically executed before and after
the restore procedure. Click Edit to open the Edit Command window and input the
command, its arguments and the working directory, or browse folders to find a batch
file. Interactive commands (commands that require user input) are not supported).
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8.4.2 Restoration Priority
You can set up the restore process priority:
•

Low - the restore process will run slower, but it will not influence other
processes running on your computer

•

Normal - set by default. The restore process will run with normal priority

•

High - the restore process will run faster, but it may influence other
processes running on your computer

Changing the restore process priority may have an adverse effect on the performance
of other programs running simultaneously. The priority of any process running in the
system determines the amount of CPU usage and system resources allocated to that
process.
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8.4.3 User Account Ownership
You can set association rules for mailboxes being restored.
With Recreate absent accounts … checkbox selected, missing in the Active
Directory accounts, whose mailboxes are being restored, will be recreated with the
specified password (by default the password is P@ssw0rd). You may also disable these
accounts after the restore process complete.
To associate restored mailboxes with their user accounts in Active Directory, select the
corresponding parameter. Otherwise you will have to reconnect all restored mailboxes
to their users manually. After the restore task is completed, execute Run Cleanup
Agent in the Microsoft Exchange System Manager, and then reconnect each mailbox
(right-click a mailbox, choose Reconnect, then select the required user and click OK).
To be able to use the account restore feature under Windows 2000 domain,
you should install SSL certificate. For more details please visit
http://support.microsoft.com/kb/247078/ and
http://windowsitpro.com/article/articleid/14923/how-do-i-install-an-enterprisecertificate-authority.html
For the correct performance of the user account ownership feature, please make sure
there are no domain policies conflicts.

8.4.4 Additional Settings
Backup archive validation
Before data is restored from the archive, Acronis Recovery for MS Exchange can check
its integrity. If you suspect that the archive might have been corrupted, select
Validate backup archive before restoration.

Overwriting mode
Enable Overwrite existing e-mails parameter to make Acronis Recovery for MS
Exchange overwrite existing e-mails with restored ones.
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While restoring to another storage group overwrite database with the
same name
With this parameter selected, databases will be overwritten with databases with the
same name from the archive. Otherwise, restoring such databases will fail.

8.5 Acronis Active Restore or Dial Tone Recovery?
Acronis Recovery for MS Exchange allows a faster databases recovery using two
methods – Acronis Active Restore and dial tone mode. This section describes
differences and advantages of each method.

Using Acronis Active Restore
After starting the restore task with Acronis Active Restore feature activated, Microsoft
Exchange databases will be dismounted. Then, Acronis Recovery for MS Exchange will
check free space in the temporary folder, selected for logs. If there is not enough free
space to locate logs, the task will fail, and databases will remain dismounted.
Acronis Active Restore acts the following way: after starting a restore task, a backed
up database is mounted directly from the archive. Then transaction logs, which are
being taken from the archive, will be applied. It is important, that database becomes
available for users after a short time – users can work with their folders, calendars, emails. All other data is being restored from the archive in the background. After the
restore operation is completed, the database will be remounted, which takes less, than
a minute.
Please note, using Acronis Active Restore is inefficient if archives are located
on tapes or ftp servers – this operation may be time consuming.

Using Dial Tone Recovery
Restoring a huge Microsoft Exchange Server database may take several hours before
users can start working with it again after a disaster. But Acronis Recovery for MS
Exchange makes it possible to use a dial tone to recover e-mail service in the first
place, and only then restore users’ data as it becomes available (only in Microsoft
Exchange Server 2007).
Main advantages of using dial tone mode are independence from the log’s size and
almost instant access to the e-mail service.
At first, a temporary empty dial tone database will be created. Microsoft Exchange
Server will create new mailboxes (with the same GUID values as the old ones) in this
database, so that users can start sending and receiving e-mails, but other data (such
as contact lists, rules, stored e-mails, etc.) still will not be available. This process takes
only two minutes or even less. After restoring the database to the selected location
and applying logs, all recovered data will be merged with new e-mails (which were
sent or received during the dial tone recovery) bringing mailboxes to the up-to-date
state, which takes the database off-line for several minutes. On operation completion,
temporary dial tone databases will be deleted.
Note, public folders can not be restored using dial tone mode, i.e while
restoring storage groups, which contain mailboxes and public folders, only
mailboxes will be restored. We recommend you to restore public folders
separately, not using dial tone mode.
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Comparing Acronis Active Restore and Dial Tone Recovery
Acronis Active
Restore

Dial Tone
Recovery

MS Exchange accessibility while
restoring

yes

limited

Public folders restoring

yes

no

Supported MS Exchange editions

all editions

only MS Exchange
2007

Depends on logs size

yes

no
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Chapter 9. Scheduling Tasks

9.1 What is a task?
A task is a job you execute for a database that includes the type of operation (backup,
restore, etc.), parameters of the operation (what to backup, what to restore, etc.) and
a schedule (optional). Each time you want to perform an operation with specific
parameters, you should create a task. Once the task is created, you can execute it
manually at any time or run it on a scheduled basis (if provided). You can also
schedule independent or redundant tasks for the same information store or storage
group.

9.2 Setting Schedule Parameters
You can run a task manually or specify the frequency (Daily, Weekly or Monthly).
Manually – this option allows you to create a task without specifying the exact
schedule of its execution. The created task appears in the task management list and
may be run at any time.
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Daily - the task will be executed daily at the specified time. You can set the following
parameters:
Parameter

Description

Recur every (…) The task execution frequency
days
Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions throughout the day (in
minutes or hours)

End time

Time when the schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule

End date

Select this check box to specify the date when this schedule will
be disabled

Weekly - the task will be executed on a weekly basis at the specified time and days.
You can set the following parameters:
Parameter
Recur
weeks

every

Description
(…) The task execution frequency. Select individual days of the
week, all days or only workdays.

Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions during the day (in hours)

End time

Time when the schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule
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End date

Select this check box to specify the date when this schedule will
be disabled

Monthly - the task will be executed monthly at the specified time and day. You can
set the following parameters:
Parameter

Description

Months

Select months for the task execution from the drop-down list.
Then choose one of the following parameters:
Days - choose this parameter to specify days of the selected
months for task execution. Choose the dates from the dropdown list. Also you can select Last (to execute the task on the
last day of the chosen months) or All days. For example, if you
have selected “15” and “Last”, the task will be executed on
every 15th and every last day of the selected months.
On - choose this parameter to select a week number of the
month (also Last or All) and the day of the week (as well as
All days and All Workdays) for task execution. For example,
if you have selected “First” and “Monday”, the task will be
executed on the first Monday of the selected months.

Start time

Time for starting the task. The current time is set by default

Repeat

Task execution frequency: Once for a single execution and
Every (…) for periodic executions during the day (in hours)

End time

Time when this schedule will be disabled

Start date

Select this check box to specify the date to enable this schedule

End date

Select this check box to specify the date when this schedule will
be disabled
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One time - the task will be executed once at the specified time and day. You can set
the Start time parameter: specify the date and time to start the operation. Current
time is set by default.

All the settings you made are displayed in the Result field at the bottom of the
window.
To save your settings, click OK.
To quit task scheduling without saving, click Cancel.
Note, Acronis Recovery for MS Exchange allows you to set multiple schedules for one
task. For example, you can backup your data not only once a week, but also on the
last day of each month. You can specify Weekly and Monthly parameters to have the
necessary operation schedule.
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Chapter 10.

Managing Tasks

To manage operations, click Manage Tasks in the Pick a Tool group or select the
Tools -> Manage tasks menu item.
All the scheduled tasks appear in the Scheduled Tasks pane in the Manage Computer
Tasks window of the Acronis Recovery for MS Exchange Management Console.
Information about the task name, credentials, the type of backup, its status
(completed, scheduled), the task’s schedule and the date and time when it was run
last is displayed.
You can edit, start, and delete the scheduled tasks from these windows, as well as edit
the scheduled set of tasks.
Note, backup tasks may consist of two subtasks: full and incremental backups.
You can manage these subtasks separately.
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10.1 Editing a Task
To edit a task, select it in the Tasks window and click Edit Task on the left. Follow the
wizard’s instructions on the screen.

10.2 Deleting a Task
To delete an existing task, select it in the Tasks window and click Delete Task on the
left. Follow the wizard’s instructions on the screen.

10.3 Starting a Task
To begin executing an existing task immediately, select it in the Tasks window and
click Start Task Now on the left.

10.4 Viewing a Disaster Recovery Plan
Click the View Disaster Recovery Plan link in the tasks pane. The plan is provided
in HTML format. See details in Chapter 6 “Disaster Recovery Plan”.
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Chapter 11.

Notifications

Acronis Recovery for MS Exchange can notify you when a task is complete using an
SNMP service or via e-mail.
By default all notifications are disabled.

11.1 E-mail Notifications
Specify a singular default e-mail account that will be used for notifications regarding
the backup operation process. Provide the e-mail address to which notifications will be
sent and the outgoing SMTP server name. A username and a password may also be
needed if the SMTP server requires authentication.
You can choose when you want to receive notifications:
•

after successful completion of the operation

•

if the operation fails

You can also add full log to notification selecting the corresponding parameter.

100

Click the Additional e-mail parameters… link to specify the From and Subject
fields for the notification e-mail.
You can check if the settings are correct by clicking the Send Test E-mail Message
button.

11.2 SNMP
You can choose whether to send event log messages issued by Acronis Recovery for
MS Exchange to computers running SNMP (Simple Network Management Protocol)
management applications.
To specify SNMP settings, check the Send Notification with SNMP parameter to enable
SNMP notification.
In the Community Name field, enter the name of the SNMP community to which
both the Host (the computer running the SNMP management application) and the
computer running the task belong.
In the Host Name field, enter the name of the computer running the SNMP
management application, to which notifications will be sent. If not specified, messages
will be sent to all SNMP clients found in the local network.
Below in this window you can choose whether you want to get notifications:
•

upon the operation's successful completion parameter

•

upon the operation failure parameter

You can check if the settings are correct by clicking the Send test SNMP message
button.

11.3 Windows event log
You can save event messages to the Windows Event Log (to see this log, run
eventvwr.exe or select Control Panel -> Administrative tools -> Event Viewer).
To save event messages to Windows Event Log select the Save messages option and
choose one of the following from the drop-down list:
•

All events - all events (information, warnings and error messages) will be
recorded to the Windows Event Log

•

Warnings and errors - warnings and error messages will be recorded to
the Windows Event Log

•

Errors only - only error messages will be recorded to the Windows Event
Log
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Chapter 12.

Viewing Logs

Acronis Recovery for MS Exchange working logs. The logs provide information about
scheduled task results, including failure reasons, if any. To view logs, click the Logs
item in the Pick a Tool group.
The log browsing window contains two panels: the left panel features the log list, and
the right panel displays the selected log’s contents. You can set up list parameters to
only display messages of a particular type, display particular columns, or select a
sorting order.
To the left, there are 3 message filter options:
•

filter error messages

•

filter warnings

•

filter information messages

To select columns to display, click the button and check columns to display.
To sort messages by a particular column, click its header (click again to reverse the
order) or the button (the second from the right) and select the desired column.
You can also change column width by dragging its borders with the mouse.
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Chapter 13.

Command-line Mode

Acronis Recovery for MS Exchange supports the command-line mode. The commandline user interface provides the ability to execute the following Acronis Recovery for MS
Exchange functionality: backup and restore (including the ability to set options for
corresponding operations).
There are six operations you can run in command-line mode:
•

List – displays contents of a an item if specified (child items, list of archives in
a specified folder, etc.) or contents of an archive

•

Info – displays information about specified items, such as a name of a storage
group, number of its databases, their total size, etc

•

BackupIS – back up required information stores (database level backup), as
well as specify backup options

•

BackupMB – back up required mailboxes (brick-level backup), also specify
backup options

•

RestoreIS – restore required information stores, as well as specify restore
options

•

RestoreMB – restore required mailboxes, also specify restore options

Commands may be accompanied with options.
It is important to keep the prescribed order of specifying parameters.
Note, parameters should be entered in double quotes in case they contain
non-Latin symbols (see usage examples).
To view all available commands and their options, execute the following command
Cmd.exe [/h] [/?] in command line prompt.
Below are sections describing each command and their options with corresponding
usage examples.
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13.1 List Command
Cmd.exe
list
[/location:<URI>
[/credentials:"<login>:<password>"]
[/archive:<name> [/password:<password>]]] [/item:"<item>"] [/pit:<time>]

13.1.1 Description of Options
/location:<URI>
Specifies an archive location’s URI. The path may be specified in one of the
following
ways:
“C:\path\to\dir\”,
“\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.
/credentials:<login>:<password>
Specifies task execution account’s credentials
/archive:<name>
Specifies an ID of an archive within the specified location
/password:<password>
Specifies a password if an archive was created with password protection
/item:<item>
Specifies a parent item in the following format:
“//StorageGroup_name/Database_name/Mailbox_name/Folder_name”. It can
be null for storage groups
/pit:<date><time>
Specifies a point in time to list items in from. If no value is set, the command
will return all available restore points. The time format depends on a system
locale of the particular computer (i.e. “01.06.2008 12:07:55”). The value can
also be <latest> that means the latest backup, and <pof> - point of failure (the
default value)

13.1.2 Usage Examples
•

cmd.exe list /item:”//StorageGroup1”
This command will list all mailboxes of Storage Group 1

•

cmd.exe list /location:”bsp://host/BackupServer” /archive:archive1 /pit:latest
This command will list all storage groups in archive1 located in
bsp://host/BackupServer

13.2 Info Command
Cmd.exe
info
[/location:<URI>
[/credentials:"<login>:<password>"]]
[/archive:<name> [/password:<password>]] /item:"<item>" [/pit:<time>]

13.2.1 Descriptions of Options
/location:<URI>
Specifies an archive location’s URI. The path may be specified in one of the
following
ways:
“C:\path\to\dir\”,
“\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.
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/credentials:<login>:<password>
Specifies task execution account’s credentials
/archive:<name>
Defines an archive within the specified location
/password:<password>
Specifies a password if an archive was created with password protection
/item:<item>
Specifies a parent item information
“//StorageGroup1/Database1/User/inbox”

in

the

following

format:

/pit:<date><time>
Specifies a point in time to display items. The time format depends on a system
locale of the particular computer (i.e. “01.06.2008 12:07:55”). The value can
also be <latest> that means the latest possible state, and <pof> - point of
failure (the default value)

13.2.2 Usage examples
•

Cmd.exe
info
/location:”bsp://host/BackupServer”
[/credentials:”admin:qwerty”] /archive:<archive1> [/password:<password>]
This command

will display

bsp://host/BackupServer

information about

archive1 located

in

13.3 Backup Commands
13.3.1

BackupIS

Use BackupIS command to back up whole information stores and storage groups. In
case you specify mailboxes in the item option, the operation will fail.
See options’ description in 13.3.3 section.

Cmd.exe backupIS /location:<URI> [/credentials:"<login>:<password>"]
/archive:<name> [/item:"<item>"] [/backupType:Full|Incremental]
[/compression:None|Normal|High|Maximum|Ultimate] [/encryption:"None|AES
128|AES 192|AES 256:<password>"] [/substitute]
[/throttle:<throttle>] [/validate]
[/priority:Low|Normal|High]

13.3.2

BackupMB

Use BackupMB command to back up separate mailboxes. In case you specify
information stores or storage groups in the item option, the operation will fail. This
command will force a brick-level backup method.
See options’ description in 13.3.3 section.

Cmd.exe backupMB /location:<URI> [/credentials:"<login>:<password>"]
/archive:<name> [/item:"<item>"] [/backupType:Full|Incremental]
[/compression:None|Normal|High|Maximum|Ultimate] [/encryption:"None|AES
128|AES 192|AES 256:<password>"] [/substitute][/throttle:<throttle>]
[/validate][/priority:Low|Normal|High]
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13.3.3 Description of Options
/location:<URI>
Displays an archive location’s URI. The path may be specified in one of the
following
ways:
“C:\path\to\dir\”,
“\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.
/credentials:<login>:<password>
Task execution account’s credentials
/archive:<name>
Specifies an ID of an archive within the specified location
/item:<item>
This parameter is optional and specifies a parent item in the following format:

“//StorageGroup_name/”
To back up all storage groups set “//” as the parameter’s value. If this
parameter is not specified, the whole information store will be backed up
/compression:<None|Normal|High|Maximum|Ultimate>
Specifies archive compression level. Normal is set by default
/backupType:<Full|Incremental>
Specifies a type of backup to be created.
/encryption
/encription:<”AES 128|AES 192|AES 256”>
Specifies the encryption method of the created archive
/password:<password>
Specifies a password if an archive was created with password protection
/substitute
Specifies substitution
/throttle
Specifies throttle bandwidth in kb/s (the value can be from 0 to 100000 kb/s)
/validate
Specify this parameter to validate the created backup archive
/priority:<Low|Normal|High>
Specifies priority of the backup operation

13.3.4 Usage Examples
•

Cmd.exe backupMB /location”:bsp://host/BackupServer” /archive:archive1
/item:”//MyStorageGroup/MyDatabase/MyAccount” /credentials:”admin:qwerty”
This command will back up MyStorageGroup/MyAccount to the
bsp://host/BackupServer folder, the created archive will be called
archive1, credentials will be used: admin (login) and qwerty (password)
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13.4 Restore Commands
13.4.1 RestoreIS
Use RestoreIS command to restore whole information stores and storage groups. In
case you specify mailboxes in the item option, the operation will fail.
See options’ description in 13.4.3 section.

Cmd.exe restoreIS /location:<URI> [/credentials:"<login>:<password>"]
/archive:<name> [/password:<password>] [ /item:"<item>"
[/storagegroup:<storagegroupname>][/activerestore] [/dialtone
[/overwriteDialtoneDB]]] [/pit:<time>] [/priority:Low|Normal|High] [/validate]
[/overwriteExistingEmails] [skipExistingDatabases]

13.4.2 RestoreMB
Use RestoreMB command to restore separate mailboxes. In case you specify
information stores or storage groups in the item option, the operation will fail.
See options’ description in 13.4.3 section.

13.4.3 Description of Options
/location:<URI>
Specifies an archive location’s URI. The path may be specified in one of the
following
ways:
“C:\path\to\dir\”,
“\\computer\share\dir\”,
“ftp://host/mybackups/” or “bsp://host/BackupServer”.
/credentials:<login>:<password>
Task execution account’s credentials
/archive:<name>
Specifies an ID of an archive within the specified location
/password:<password>
Specifies a password if an archive was created with password protection
/item:<item>
This is an optional parameter. It specifies a parent item in the following format:
“//StorageGroup_name/Database_name/Mailbox_name/Folder_name”
To restore all storage groups set “//” as the parameter’s value. If this
parameter is not specified, the whole information store will restored
/activerestore
Specify this parameter to use Active Restore mode (for restoring storage
groups only)
/dialtone
Specify this parameter to use dial tone mode (for restoring storage
groups only)
/overwriteDialtoneDB
Specify this parameter to enable overwriting dial tone databases
(acceptable while restoring storage groups only)
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/storagegroup
Specifies a storage group to restore. All specified storage groups will be
overwritten. Note, this option is incompatible with /dialtone command
/pit:<date><time>
Specifies a point in time to which to restore the required item. The default value
is <pof> that means the point of failure. The time format depends on a system
locale of the particular computer (i.e. “01.06.2008 12:07:55”).
/validate
Specify this parameter to validate the backup archive before restoring
/priority:<Low|Normal|High>
Specifies priority of the restore operation
/overwriteExistingEmails
Forces overwriting existing e-mails
/skipExistingDatabases
Specify this parameter to skip restoring existing databases

13.4.4 Usage Examples
•

Cmd.exe restoreIS /location:”bsp://host/BackupServer” /archive:archive1
/item:”//MyStorGroup1” /itemLogon:admin:qwerty /item:MyStorGroup2
This command will restore MyStorGroup1 and MyStorGroup2 from the
archive called archive1, located in bsp://host/BackupServer
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Appendix A. Acronis Recovery for MS
Exchange: Best Practices
This section provides instructions for best practices when using Acronis Recovery for
MS Exchange.

A.1 Protect your server from hardware failure, user errors
and viruses
Scenario
The company is running several internet and intranet applications on several Windows
2000 servers using Microsoft Exchange as the back end (using different information
stores). Since all transactions are stored in the database, any data loss is not
acceptable. The database administrator must provide protection from hardware failure,
user errors and virus attacks.

Acronis solution
Use the following components
 Acronis Recovery for MS Exchange Agent (on all servers with databases)


Acronis Recovery for MS Exchange Management Console (on an administrator
workstation, from which you plan to manage tasks)

To schedule periodic backup
1. Install Acronis Recovery for MS Exchange Management Console on the
database administrator workstation and Acronis Recovery for MS Exchange
Agents on the server where Microsoft Exchange information stores are located
For every Microsoft Exchange instance perform the following actions:
2. Connect to the server from the Acronis Recovery for MS Exchange Management
Console using the appropriate credentials
3. Launch the Create Backup wizard and follow the instructions to create a
backup task:
a. Select the whole Microsoft Exchange instance (or all available instances)
as a backup source
b. Select a backup destination
c. Select Full and Incremental backups type
d. Schedule full backups for every month, incremental backups for every
week
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e. Use default settings for backup
f. Add the necessary comments for the task
g. Save the created task
To recover all data in case of hardware failure
For every damaged server perform the following actions:
1. Install and configure a new server. Install the necessary Microsoft Exchange
information stores on the server.
2. Install Acronis Recovery for MS Exchange Agent on the server
3. Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials
4. Launch the Restore Data wizard and follow the instructions to restore the
database:
a. Select the backup archive location
b. Select the Restore to point of failure option
c. Select the whole Microsoft Exchange information store (or several
storage groups) to restore from, then specify the target storage group
for each storage group.
d. Start the restore operation
All Microsoft Exchange storage groups will be restored to the point of failure
to avoid data loss.
To recover all data in case of a user mistake
For all servers perform the following actions:
1. Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials
2. Launch the Restore Data wizard and follow instructions to restore the
database:
a. Select the backup archive location
b. Select the Restore to point in time option and specify the date and
time manually, or select the backup from the list of backups.
c. Select the database to restore from the archive
d. Start the restore operation
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Only one database will be restored to the selected point in time.
To recover all data in case of a virus attack
For all servers perform the following actions:
1. Recover the server from viruses, reinstall the operating system or replace the
server with a new one.
2. Connect to the server from Acronis Recovery for MS Exchange Management
Console using the appropriate credentials
3. Launch the Restore Data wizard and follow the instructions to restore the
database:
a. Select a backup archive location
b. Select the Restore to a point in time option and specify the date and
time manually or select the required backup from the list of backups.
c. Select the whole Microsoft Exchange information store (or several
storage groups) to restore, and specify the target location for each
information store.
d. Start the restore operation
All Microsoft Exchange information stores will be restored to a point in time.

A.2 Protect your server to guarantee minimal data loss
Scenario
The database administrator must organize the server backup creation so that in case of
a server failure for any reason, the maximum data loss would not be more than 15
minutes.

Acronis solution
Connect to Acronis Recovery for MS Exchange Management Console and create a
backup task for Microsoft Exchange with the following backup strategy: Full Backup
(every week) + Incremental backup (every day).
To recover all data in case of failure, use the same procedure as described in the
previous scenario (A.1).

A.3 Backing up several databases
Scenario
The company uses only one Microsoft Exchange instance for running several
databases. All databases have different levels of importance concerning data loss:
some of them need to be backed up every day, others require only weekly backups.
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Acronis solution
The database administrator should create independent tasks for different databases.
While creating a task, the database administrator specifies the appropriate schedule for
each database.

A.4 Encrypting database archives for storage
Scenario
The company stores database backup archives off-site, hence they should be
effectively protected (encrypted).

Acronis solution
While creating a backup task, the database administrator should set a password to
protect the archive and encryption type (AES 128, 192 or 256) by specifying backup
options.
While creating the restore task, the administrator has to provide the correct password
to the archive in order to restore the data. The password should be kept in a safe
place so that data may be restored if the company hires new administrators.

A.5 Using the Disaster Recovery Plan to restore databases
Scenario
The business owner wants to be sure that the databases can be restored at any time,
even in case the database administrator is not available for any reason. For that
purpose, a comprehensive Disaster Recovery Plan should be created, which will help a
person without DBA knowledge restore damaged databases.

Acronis solution
While creating a backup task, the database administrator should specify a Disaster
Recovery Plan option, so that it would be sent to the business owner’s email. In case
of a disaster, the staff can restore databases according to the instructions contained in
the Disaster Recovery Plan.

A.6 Manual backup (before crucial changes in databases)
Scenario
The company is preparing to make extensive changes to the databases. To avoid
possible loss, the databases must be backed up.

Acronis solution
The database administrator can use previously created backup tasks and start them
manually from the Acronis Recovery for MS Exchange Management Console.
Another option is to start a new task for creating full backups. The administrator can
specify it so that it will only be executed manually.
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Appendix B. Installing Acronis Recovery
for MS Exchange from command line
Acronis Recovery for MS Exchange supports the Microsoft Installer utility (msiexec.exe)
with all its commands. Here is the MSI installation command and options:

Install Options
/i <Component.msi | ProductCode>
Installs or configures a product. ProductCode is the serial number of your
personal copy of Acronis Recovery for MS Exchange Agent
COMPONENT=[component]
Specifies the component you want to install:
AcronisRecoveryMsExchangeAgent - Acronis Recovery for MS Exchange Agent
AcronisRecoveryMsExchangeConsole - Acronis Recovery for MS Exchange
Management Console
USERNAME=[username] PASSWORD=[password]
Specifies username and password for running Acronis Recovery for MS
Exchange Agent installation
/e[path]
Specifies a path to extract an .msi file to.
/a <Component.msi | ProductCode>
Applies the administrative installation option
/x <Component.msi | ProductCode>
Uninstalls the product
Example
msiexec /i C:\ AcronisRecoveryMsExchangeAgent.msi
Installs Acronis Recovery for MS Exchange Agent.

Reinstall Options
/f[p|o|e|d|c|a|u|m|s|v] <Component.msi | ProductCode>

Reinstalls or upgrades the product
p – reinstalls only missing files
o – reinstalls the file if it is missing or it is an older version
e - reinstalls the file if it is missing or is the same or an older version
d - reinstalls the file if it is missing or a different version is present
c – verifies the checksum values, and reinstalls the file if it is missing or corrupt
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a – reinstalls all files
u – rewrites all required registry entries from the Registry Table that go to the

HKEY_CURRENT_USER or HKEY_USERS registry hive
m – rewrites all required registry entries from the Registry Table that go to the

HKEY_LOCAL_MACHINE or HKEY_CLASSES_ROOT registry hive
s – reinstalls all shortcuts and re-caches all icons overwriting any existing
shortcuts and icons
v - used to run from the source package and re-cache the local package.
This option ignores any property values you specify at the command line. The
default value for this option is /fpecms.
Example
msiexec /fpecms C:\ AcronisRecoveryMsExchangeAgent.msi
Reinstalls Acronis Recovery for MS Exchange Agent.

Advertising Options
/j[u|m]
Advertises a component with the following options:
u – only for the current user
m – for all users of the computer
/g LanguageID – identifies the language
/t TransformList – applies transform to advertised component
This option ignores any property values you specify at the command line. To install the
component with elevated privileges, use /jm.
Example
msiexec /jm C:\ AcronisRecoveryMsExchangeAgent.msi
Advertises Acronis Recovery for MS Exchange Agent for all users of the computer.

Logging Level Options
msiexec /L [i][w][e][a][r][u][c][m][p][v][+][!]LogFile.txt
/L - Specifies the path to the log file
i - Logs status messages
w - Logs nonfatal warnings
e - Logs all error messages
a - Logs startup of actions
r - Logs action-specific records
u - Logs user requests
c - Logs initial user interface parameters
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m - Logs out-of-memory
p - Logs terminal properties
v - Logs verbose output. To use v, specify /L*v
+ - Appends to existing file
! - Flushes each line to the log
* - Logs all information except for the v option. This is a wildcard
LogFile.txt - Name and path of the text log file
To include the v option into a log file using the wildcard flag, specify /L*v at the
command line.
Example
msiexec /i C:\ AcronisRecoveryMsExchangeAgent.msi /Lime logs.txt
Installs Acronis Recovery for MS Exchange Agent and creates log file logs.txt
containing information about the status, out-of-memory and error messages.

Applying a Patch Options
/p PatchPackage
/p - Applies a patch

PatchPackage - Specific patch
Example
msiexec /p PatchPackage /a C:\ AcronisRecoveryMsExchangeAgent.msi
Applies a patch to an administrative installation component.

Options for Installing a Transform
msiexec /i com ponent TRANSFORMS=Transform List
TRANSFORMS= - Property that is used to specify what transform (.mst) files
should be applied to the component

Transform List - List of paths separated by semicolons

Options for Advertising Using a Transform
msiexec /j[u][m] component /t TransformList
User Interface Level Options
msiexec /q{n|b|r|f|n+|b+|b-}
/qn - Displays no user interface
/qb - Displays a basic user interface
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/qr - Displays a reduced user interface with a modal dialog box displayed at
the end of the installation
/qf - Displays the full user interface with a modal dialog box displayed at the
end
/qn+ - Displays no user interface, except for a modal dialog box displayed at
the end
/qb+ - Displays a basic user interface with a modal dialog box displayed at the
end
/qb- - Displays a basic user interface with no modal dialog boxes
Note, /qb+- is not a supported user interface level. The modal box is not displayed if
the user cancels the installation.
Example
msiexec /qb AcronisRecoveryMsExchangeAgent.msi
Displays the basic user interface options during the Acronis Recovery for MS Exchange
Agent installation.

Copyright Information Displaying Options
msiexec {/?|/h}
Displays the Windows Installer version and copyright information.

Calling the system API DllRegisterServer Option
msiexec /y|z module
/y - Calls the system API DllRegisterServer to self-register modules passed on
the command line
/z - Calls the system API DllUnRegisterServer to unregister modules passed on
the command line

m odule - Specifies the file name of the module
These options are only used for registry information that cannot be added using the
registry tables of the .msi file.
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